
Mechanical Characterization of
Tissue Engineered Fibrous Cap

Constructs

Towards the Development of an In Vitro

Atherosclerotic Disease Model

Sheila M. Serra
MSc Thesis

Biomedical Engineering





Mechanical Characterization of Tissue
Engineered Fibrous Cap Constructs

Towards the Development of an In Vitro Atherosclerotic Disease Model

by

Sheila M. Serra

to obtain the degree of Master of Science
at the Delft University of Technology,

to be defended publicly on Wednesday, September 23, 2020 at 10:00.

Student number: 4778421
Supervisors: Dr. ir. Frank Gijsen (Erasmus MC)

Dr. Tamar Wissing (Erasmus MC)

Dr. ir. Lidy Fratila-Apachitei (TU Delft)
Prof. Dr. ir. Amir A. Zadpoor (TU Delft)

An electronic version of this thesis is available at http://repository.tudelft.nl/.





Preface

For my Master’s research graduation project, I was given the opportunity to work
on a recently developed project at Erasmus Medical Center in collaboration with the
Eindhoven University of Technology. The overall aim of this project is to create an in
vitro reproducible human-like vulnerable plaque in order to study atherosclerotic plaque
rupture mechanics, nearly impossible to study inside the body due to its stochastic nature.

Due to the COVID-19 pandemic, the study could not be completed in the way we
originally planned, introducing a strain gradient during culture to the tissue engineered
constructs and linking histology to mechanical properties, therefore the topic changed in
order to work from home. The experimental facilities were no longer available during this
time, therefore the focus of this project shifted to the constructs that had been created
and mechanically tested before the lockdown. In this study, the mechanical testing
data obtained was used for investigating the mechanical behavior of differently strained
constructs during culture and different clamping mechanisms during testing, as well as
for performing digital image correlation in order to observe local strain patterns leading
to rupture. Therefore, the study shifted to a more exploratory nature, containing a few
limitations.

Sheila Serra
Delft, September 2020
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Abstract

Atherosclerosis is a widespread disease characterized by the formation of a plaque within the
inner most layer of the arterial wall. This plaque is comprised of a lipid-rich pool containing little
to no collagen covered by a collagenous fibrous cap which serves as a barrier containing the plaque
from rupture. Plaque rupture is an often fatal phenomenon, not yet fully understood, which
can result in arterial blockage causing myocardial infarction or stroke depending on rupture
location. Whether a plaque will rupture depends on many interrelated aspects; the biological
composition of the plaque, the mechanical properties of these components, and how they are
mechanically loaded. The collagenous matrix is the main load bearing structure of the plaque
cap, therefore affects plaque stability and should be further investigated. Due to the various
limitations when studying ex vivo and in vivo human plaques as well as the significant difference
in plaque development in animal models, an in vitro atherosclerotic plaque cap model is necessary
to systematically study plaque rupture mechanics.

In this study, a simplified collagenous fibrous cap model with a soft inclusion (SI) was developed.
The effect of intermittent uniaxial straining (IS) versus no straining (static) during culture was
investigated as intermittent straining during culture is linked to an increase in alignment of
collagen fibers in the loading direction, which is seen in human fibrous caps. The constructs
were mechanically tested with two different clamp designs (commercial and redesigned), to
investigate the differences in mechanical behavior and to improve the clamping technique. The
local strain patterns were studied using digital image correlation (DIC) preceding rupture.

Although there was higher compaction observed in the IS constructs when compared to the static
constructs, the mechanical behavior of the IS and static constructs tested in the commercial
clamps were comparable. However, DIC analysis demonstrated that the static constructs in
the commercial clamps showed homogeneous εxx extension behavior, whereas the IS constructs
showed a symmetric “C-shaped” compressive pattern, signifying a possible difference in micro-
structure. Additionally, the redesigned clamps displayed a consistent two bump rupture pattern
correlating to rupture near the SI, as well as higher measured force at comparable stretch,
not seen with the commercial clamps. The redesigned clamps demonstrated an improvement
in the testing method when compared to the commercial clamps by exhibiting better load
transmission from clamp to tissue, creating more homogeneous strain distribution within the
region of interest and leading to more consistent rupture near the SI. Interestingly, high εyy
values were observed at the rupture location in both the redesigned and commercial clamps,
possibly demonstrating a linkage between high εyy extension behavior and rupture location. In
this study, collagenous constructs with an integrated SI were successfully created exhibiting
mechanical properties within the range found in literature and rupturing near the SI-tissue
interface, therefore these findings can serve as a guide for future experiments in the development
of an atherosclerotic plaque cap in vitro model.
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1
Introduction

Atherosclerosis is a global cardiovascular disease and is one of the most common causes
of mortality, often leading to myocardial infarctions and strokes. Atherosclerosis refers to
the formation of inflamed fatty lesions, also known as plaques, within the intimal layer,
the inner most layer of the arterial wall. The plaque is sealed from the blood stream by a
collagen rich fibrous cap. The collagen structure is the main load-bearing structure of the
plaque which regulates stiffness and provides its strength. Plaque rupture often leads to
thrombosis in the arterial lumen which can lead to blockage either at the site of rupture,
or further downstream. The fibrous cap of a vulnerable plaque contains various collagen
types but is most abundant in collagen type I and III, which account for approximately
ninety percent of the collagen in the cap. In the cap, collagen is synthesized by the
vascular smooth muscle cells [1]. An imbalance can occur between collagen synthesis and
matrix degradation within the cap by macrophages which may lead to rupture.

Figure 1.1: Vulnerable plaque structure. Atherosclerotic plaques form in the intima layer and when
the fibrous cap strength exceeds the arterial stresses, rupture occurs and a thrombus can form, blocking
blood flow through the lumen. *Image courtesy of Tamar Wissing
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Thin cap fibroatheromas, also known as vulnerable plaques, are known to be the precursor
to rupture. These type of fibroatheromas are defined as containing a thin collagen rich
fibrous cap, a large necrotic core containing dead cells and little to no collagen, sparse
vascular smooth muscle cells within the cap, and macrophage infiltration as part of the
inflammatory response (Figure 1.1) [2]. Many biological processes are involved leading
to plaque rupture, but in the end, it’s a mechanical event in which the local mechanical
stresses experienced by the cap exceed the local tissue strength. To properly understand
and predict plaque rupture, gaining more insight in the tissue mechanics and failure
mode, which is determined by the biological composition and its mechanical properties,
is necessary.

1.1 Motivation

Understanding atherosclerotic plaque rupture mechanics is of great clinical interest and
can aid in saving many lives. Predicting the exact time of rupture is currently impossible
due to the variety of interrelated factors that are involved in plaque rupture and the
stochastic nature of the process. Due to the existing knowledge gap and limitations
in human in vivo and ex vivo models as well as in animal models, the need for a
controllable in vitro atherosclerotic model is evident, in order to properly study plaque
formation, properties, and ultimately rupture mechanics. Collagen is known to be the
most important load bearing component of fibrous caps, therefore comprehending the
mechanical properties of collagen in human atherosclerotic arteries will lay a foundation
for creating a simplified mechanically representative model to systematically investigate
plaque rupture [3].

By first focusing on the collagen content, structure, and mechanical properties, the basis of
the in vitro model can be made. In order to simulate a fibrous cap model, the alignment of
collagen fibers in the direction of loading is necessary to replicate. In a study investigating
tissue engineered (TE) heart valves, vascular TE constructs were subjected to uniaxial
straining during culture. It was observed that the collagen fibers reoriented along the
direction of the load, matching what is seen in plaque caps (Figure 1.2) [4],[5]. Collagen
alignment in the loading direction results in a decrease of strength in the fibrous cap in
the direction perpendicular to the load making it more prone to rupture [6]. In the study,
it was demonstrated that the amount of time of straining significantly affects the collagen
composition and mechanical properties of the constructs, therefore in order to simulate a
less structured fibrous plaque cap, the straining time protocol must be altered accordingly.

Including a soft inclusion (SI) in the model to represent the mechanical stiffness of a
necrotic core is also of interest in order to investigate the mechanical effects surrounding
the SI. Additionally, other important biological components can be added to the model,
such as macrophages and micro-calcifications, which also influence the collagen structure
and stresses within the plaque (Figure 1.3). The overall goal this thesis project is working
towards is to systematically control and add different components to the model in order
to cover the complete spectrum of plaques and variability seen in vivo.
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Figure 1.2: Collagen fiber direction a) collagen orientation vector plot of a human fibrous cap
longitudinal section b) corresponding rose plot shows predominately longitudinal alignment in the cap
with respect to the lumen [6] and c) multiphoton image of a vascular TE construct subjected to 3 weeks
of uniaxial intermittent straining shows longitudinal alignment in direction of load and high collagen and
SMCs production (green:collagen, blue: smooth muscle cells) [5]

Figure 1.3: The goal of the in vitro atherosclerotic fibrous cap model is to systematically add relevant
biological components that influence rupture such as the collagenous structure created by smooth muscle
cells, micro-calcifications, macrophages, and a combination of these factors in order to simulate in vivo
rupture mechanics *Image courtesy of Tamar Wissing
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1.2 Aims of the study

The overarching aim of this project is to aid in the development towards a reproducible
in vitro atherosclerotic fibrous cap model in order to systematically study plaque rupture
mechanics. The aims of this study are the following:

1. Create TE collagenous constructs containing a SI subjected to different straining
protocol during culture: generate collagen rich constructs to simulate a simplified
model of an atherosclerotic fibrous cap and subject them to different straining
methods during culture.

2. Subject the constructs to mechanical testing and investigate their global mechanical
behavior leading to rupture: investigate the effects of straining methods during
culture on global mechanical behavior as well as the effect of clamp design.

3. Investigate local strain patterns of the constructs undergoing mechanical testing:
perform digital image correlation (DIC) analysis on the constructs from the images
obtained from mechanical testing.

4. Investigate rupture behavior of the constructs: utilize DIC analysis to study local
stain patterns in the constructs immediately before rupture to relate to rupture
location.



2
Materials and Methods

This chapter will cover the methodology carried out in this study, which was divided
into four parts. In part one, collagenous constructs were created by culturing them with
isolated human myofibroblast cells derived from the vena sephena magna. The tissue
engineering experiments included cell culture, creating a temporary fibrin-based matrix,
seeding the cell-matrix between Velcro strips, and either statically culturing them or
subjecting them to uniaxial intermittent straining (IS) during culture. In part two,
mechanical testing was performed on the TE collagenous constructs utilizing uniaxial
tensile tests. In part three, DIC analysis was performed to study the local strain patterns
of the constructs leading to rupture using the images taken during tensile testing. In
part four, data analysis was performed on the constructs, including compaction behavior
before mechanical testing as well as on the data gathered from the tensile tests. This
recorded test data was used to compare the global and local mechanical behavior of
the differently strained constructs as well as to investigate the effect of clamp design
on mechanical behavior. An overview of the methods used in this study can be seen in
Figure 2.1.

5
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Figure 2.1: Overview of study methods

2.1 Tissue Engineered Constructs

2.1.1 Cell Culture

Vascular cells such as myofibroblasts are often used to create tissue engineered
cardiovascular constructs. Specifically, human vena sephena derived myofibroblasts
(HVSCs) are known to produce excellent in vitro collagen and tissue strength, and are
easily accessible as well [7]. Due to these factors, these cells were selected for creating
the collagenous constructs.

For the cell culturing experiments, vascular-derived myofibroblasts were acquired from
the human vena sapehna magna of a sixty-three year old woman donor after coronary
by-pass surgery according to Dutch guidelines for secondary use material [8],[9]. The
cells were isolated according to established protocols and stored in liquid nitrogen until
usage [7]. The cells (0.5x106) were cultured in growth medium consisting of Advanced
Dulbecco’s Modified Eagle Medium [a-DMEM; Gibco, Carlsbad, CA], supplemented with
10% fetal bovine serum [FBS; Greiner Bio-One, Monroe, NC], 1% penicillin streptomyocin
[PenStrep; Lomza, Belgium] and 1% GlutaMax [Gilco, Carlasbad, CA]. The cells were
cultured at 37◦C in a humidified 95/5% air/CO2 incubated environment. The growth
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medium was renewed every 2-3 days. The cells were passaged when they reached about
80% confluency, which refers to the percentage of the culture flask surface covered with
adherent cells. Confluency above 80% can trigger intracellular mechanisms to occur
such as changes in gene expression or causing the cells to die off, thereby effecting the
results of the experiment [10]. Once approximately 80% confluency was observed for
each passage, the cells were washed with phosphate-buffered saline (PBS), dislodged with
Trypsin-EDTA solution [Life Technologies, Thermo Fisher Scientific, Inc., USA], checked
to see if they were loosened under the microscope (rounded), centrifuged, resuspended
in new medium, and added to new containers. The cells were counted after passage 7
(approximately 3 weeks).

2.1.2 Engineered Fibrous Cap Models

For the preparation of the molds in which the cells were seeded into, two 15x5 mm
Velcro strips (nylon fabric with many tiny hooks) were placed on each side of the seeding
location per construct. This allows the cells to integrate into the strips and provide a
grip for mechanical testing. The hard sides of the Velcro strips were carefully glued 10
mm apart onto each well of the cell culture plate using medical adhesive silicone [Silastic;
DOW Corning, USA] (Figure 2.2). The silicone glue was allowed to dry overnight in
an oven at 60◦C and sterilized by adding 70% ethanol to the wells and incubated for
30 min. They were washed 3x with PBS and placed under ultraviolet light for 30 min.
Rectangular polydimethylsiloxane (PDMS) bars (10x4x4 mm) were created by mixing a
silicon elastomer base and a curing agent and were sterilized using 70% ethanol. These
bars were placed between the Velcro strips, on each side in order to prepare a mold for
the fibrin-cell suspension to solidify during the initial phase of the culturing process, and
were removed on day 5 (Figure 2.3).

Figure 2.2: The Velcro strips were cut with 15x5 mm dimensions and two were pasted 10 mm apart
within the culture wells: a) top view of the reference used to place the Velcro’s at the correct location
within the wells b) one Velcro strip has been pasted using the reference under the well, another strip will
be pasted in the dotted white region
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After counting the total number of cultured cells grown, the fibrin-based matrix was
created, each construct seeded with 675,000 cells. The protocol used can be found in
Appendix A. Using fibrin gel as a cell carrier has been studied as a method that can
offer several advantages. Seeding the cells with fibrin (temporary matrix) allows the
cells to create their own mature extracellular matrix [9]. Therefore, in this study, twelve
fibrin-based constructs were created in order to provide a temporary support matrix for
the myofibroblasts to proliferate and produce their own matrix. To produce the fibrin
matrix, the cells previously cultured were added to 10 IU/mL of bovine thrombin [Sigma,
St. Louis, MO]. 10 mg/mL of bovine fibrinogen [Sigma, St. Louis, MO] was then added
to the thrombin-cell suspension.

The fibrin-cell suspension was seeded between the two Velcro strips and two PDMS bars,
as well as on top of the Velcro strips, and incubated for 30 minutes in the incubator to
gelate. The culture medium was added to the culture plate consisting of growth medium
supplemented with L-ascorbic acid 2-phosphate (vitamin C, 0.25 mg/ml) and ε-Amino
Caproic Acid (ACA, 1 mg/ml). Vitamin C and ACA were added to the medium to
stimulate collagen synthesis and slow down the fibrin degradation, respectively. The
medium was replaced every 3 days with ACA being added for the first 7 days, to allow
cells to deposit their first matrix [8],[9].

The fibrin-based constructs were first exposed to 7 days of static culture to achieve
mechanical integrity. On day 7, 2 mm centered holes were created in the constructs
using a sterile biopsy puncher in order to create a SI representative of the low stiffness
necrotic core in arterial plaque. The same concentrations of 10mg/ml fibrinogen and
10u/ml thrombin were mixed to create the fibrin gel for the SI, excluding the HVSCs.
The holes in the constructs were filled with the newly made fibrin gel, allowed to solidify
for 15 minutes in an incubator, and then fresh medium was added to the wells without
ACA. The stiffness of the fibrin-based gel SI created was approximately 0.5-1.0 kPa [11].
The SI should be substantially less stiff than the tissue constructs because the HVSCs
produce their own collagenous matrix over time which increases the structural integrity
of the tissue. Figure 2.3 displays a construct on the day of seeding and on the day of
creating the SI. The constructs continued to be statically cultured for 14 more days
at 37◦C in a humidified 95/5% air/CO2 incubated environment. The constructs were
sacrificed on day 21 for mechanical testing or fixation for future histology analysis.
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Figure 2.3: An example of a static construct on day 0 after seeding the fibrin-cell matrix between two
PDMS bars (a) and on day 7 after including the SI (b)

2.1.3 Including Previously Created Constructs

As mentioned in the preface, a few limitations were encountered during this project
due to the COVID-19 pandemic, such as time restrictions and limited lab accessibility.
Due to these limitations, the analysis performed in this project utilized 3 of the
constructs created in the experimental batch mentioned above, as well as 4 static and 4
intermittently strained constructs created previously. All static constructs followed the
same protocol mentioned above and all constructs included a centered SI.

Uniaxial intermittent straining during culture was introduced on day 14 using the Flexcell
FX-4000T system (Flexcell Int, McKeesport, PA), as shown in Figure 2.4. One week
of intermittent straining was applied to the 4 constructs via a vacuum system on the
left and right sides and consisted of one hour of 4% strain and three hours of 0% strain
(Figure 2.5). Three weeks of intermittent straining has been shown to significantly increase
collagen production in vascular tissue engineered constructs, however one week was used
in this protocol as the fibrous cap typically contains less amount of collagen overall when
compared to normal arterial tissue [5].

Figure 2.4: Adapted protocol used for culturing the constructs. The control group included the statically
cultured constructs (n=4). Intermittent straining was performed on group 1 (n=4) for one week after
two weeks of static culturing (0.5 Hz, 4-5% strain, 1 hr on + 3 hrs off) [5]
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Figure 2.5: The Flexcell system subjected the constructs to uniaxial intermittent straining via a vacuum
system on each side of the loading post where the construct has been seeded (Flexcell Int, McKeesport,
PA): a) side view schematic of Flexcell system b) top view of a intermittently strained construct within
the Flexcell system. Note: graphite particles were applied to the construct to track strain pattern

2.2 Mechanical Testing

2.2.1 Experimental Setup

A commercial biaxial tester [CellScale Biomaterial Testing, Waterloo, Canada] was used
to perform the uniaxial tensile testing with two 5 newton (N) load cells (Figure 2.6). Two
identical clamps, that were included with the system, were used to secure the constructs
in place, with the edge of the Velcro aligning with the edge of the clamp. Black graphite
specks removed from sandpaper were manually applied on top of the tissue samples using
cotton swabs for digital image correlation analysis. The constructs were lowered into a
pre-warmed (37◦C) bath of PBS to simulate physiological conditions. A high resolution
camera and lens were included in the testing setup and were located directly above the
constructs, used to capture 15 images per second during testing. Two adjustable light
sources were also included and positioned above the construct, at angles that did not
obstruct the camera view.



11 CHAPTER 2. MATERIALS AND METHODS

Figure 2.6: Commercial uniaxial tensile tester with the components referred to [CellScale Biomaterial
Testing, Waterloo, Canada]

The system was first calibrated with a spring of 5 N stiffness. The constructs were
pre-loaded to approximately 15 mN measured in the Y-direction in order to remove slack
and subsequently pre-conditioned 10x with 10% strain in order to produce repeatable
behavior [12]. The tensile tests were performed at a strain rate of 100% min-1 until
failure. The forces experienced in the tissue constructs were recorded during testing. The
mechanical testing protocol can be found in Appendix A. Figure 2.7 displays a construct
mounted in the mechanical testing setup with the commercial clamps (originally used)
and with the redesigned clamps.
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Figure 2.7: A construct mounted into two different clamping mechanisms for mechanical testing: a)
commercial clamps b) redesigned clamps; top clamp shows how the construct is snugly fit onto the
sandpaper groove before tightening the top piece

2.2.2 Clamp Redesign

It was observed that the rupture location for each construct occurred at the interface
between the tissue and Velcro/clamp edge. Therefore, it was predicted that the clamps
that came with the mechanical testing setup could be causing a stress concentration
within the clamping mechanism, ultimately causing rupture of the constructs to occur
at the Velcro/clamp edge. To test this hypothesis, special clamps were designed and
manufactured to redistribute the stresses within the clamps and improve the load
transmission from the clamps to tissue. The redesign concept can be seen in Figure 2.8
and the specifications of the redesigned clamps can be found in Appendix B. Sandpaper
and foam tape were used to grip the tissue with more of an even stress distribution as
opposed to the concentrated clamping mechanism apparent in the system clamps [13].
Also, in the redesign, 2 mm of the tissue from the Velcro on each side was gripped onto
with the new clamps, in order to provide sufficient grip. The grip heights also differed
for the Velcro and tissue due to the different thicknesses of these features, which was
incorporated into the design. In this thesis report, the system clamps will be referred to
as the commercial clamps and the newly manufactured clamps will be referred to as the
redesigned clamps.
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Figure 2.8: Comparison of the original clamps and redesigned clamps: side and top view of the original
clamps (a & c), side and top view of the redesigned clamps (b & d). The redesigned clamps were created
specifically to avoid failure at the Velcro/clamp edge by evenly redistributing the stresses within the grip.
*Images depict only one of the two clamps in the system

2.3 Digital Image Correlation

Two-dimensional DIC was performed on the images captured by the high resolution
camera (15 images per second) in order to calculate the local displacement and strain
fields on the constructs. The MATLAB open-source software Ncorr was used to perform
DIC analyses (see Appendix C). The images included began after the pre-loading and
pre-conditioning phase and ended immediately before rupture was observed. Each image
was correlated with the first image of the set, which was referred to as the reference image
that was undeformed. Using the first image as the reference image is the common method
for materials that do not experience high strains (200-300%) [14]. Since the constructs
in this project only stretched approximately 20-30% before rupture, this method was used.

In DIC, the region of interest is broken down into multiple subsets of a selected size.
The relative position’s of these subsets are then compared as the sample deforms and
are used to calculate displacements and derive the strain fields. The optimal subset
size selected for each TE constructs in this project were determined using a parameter
analysis method which reduced noise and minimized smoothing, described in Appendix
D. A trade-off must be made when selecting the parameters between smoothing of the
data to decrease noise and accuracy. The Green-Lagrangian strains were calculated
using a technique in which least squares plane fitting was performed on a region of
displacement data (determined by the selected strain radius) [15]. The displacement
gradients were then calculated and used to determine the strains (this study reports the
Green-Lagrangian strains). The method for computing the Green-Lagrangian strains is
included in Appendix C.
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To verify the appropriate parameter selection, 2D correlation coefficient maps were
generated in MATLAB using the stored correlation coefficient data CCC from the DIC
parameter analyses. The mathematics behind this quality matching process can be seen
in Appendix C and the procedure to generate the 2D correlation coefficient maps for
each construct can be seen in Appendix D. In this study, a CCC cutoff value was chosen
for the final analyses which included values correlating to a moderate-strong agreement
in grayscale values, especially near the SI.

2.4 Data Analysis

2.4.1 Compaction Analysis

Tissue compaction represents the amount of shrinkage in a certain direction. Images were
taken of each construct on a grid background on day 21, before performing mechanical
testing, in order to calculate the compaction. The final thickness values across the
construct’s length before testing were recorded using a digital microscope [Keyence VHX-
500FE, Itasca, IL] and averaged. The initial thickness values were estimated using the
total seeding volume and area dimensions. The average compaction in X, Y and Z
directions were calculated for the static and IS constructs using ImageJ [16] and plotted in
MATLAB [2017b MathWorks, Massachusetts, USA]. The code can be found in Appendix
E.

2.4.2 Global Mechanical Analysis

To investigate the global mechanical behavior of the constructs, the actuator Y
displacement and global Y force values measured in the tissue constructs were recorded
and plotted. These values are proportional to the nominal engineering stress and
strain values. The tangential moduli were calculated, as a measure of stiffness, for the
constructs tested in the redesigned clamps at the location of the actuator Y displacement
value in which the ε10% was recorded, further elaborated on in the next section.



15 CHAPTER 2. MATERIALS AND METHODS

To convert from actuator Y displacement (∆Y in µm) to stretch ratio (λ), Equation 2.1
was used, where Lo represents the original length (µm) of the construct before testing. To
convert from Y force (Fy in mN) to nominal engineering stress (σ in kPa), Equation 2.2
was used, where Ao represents the original cross sectional area (m2). Ao was determined
by multiplying the average initial thickness values of each construct on day 21 before
mechanical testing by the initial width at the maximum compaction location.

λ = 1 +
∆Y

Lo
(2.1)

σ =
Fy
Ao

(2.2)

In order to calculate the tangential moduli for each construct, a few material models (i.e.
Neo-Hookean, Mooney-Rivlin) were fit to the stretch-stress data in ABAQUS and the best
fit was selected. The 5-parameter Mooney-Rivlin strain energy density function fit the
data best (Figure 2.9). This function can be used to characterize non-linear, hyperelastic
materials with up to 100% deformation typically, and the constructs in this study did not
exceed 40% before rupture [17]. The strain energy density function equation is shown
below (Equation 2.3).

W = c10(I1 − 1) + c01(I2 − 1) + c20(I1 − 1)2 + c02(I2 − 1)2

+ c11(I1 − 1)(I2 − 1) +
1

d
(J − 1)2 (2.3)

where I1 is the first invariant, I2 is the second invariant, J is the Jacobian of the
deformation gradient tensor, c10, c01, c20, c02 and c11 are material constants. In this study,
incompressibility is assumed therefore J=1. Through derivation of the above equation,
the Second Piola Kirchhoff uniaxial nominal stress equation can be derived with respect
to stretch (shown in Equation 2.4).

σ = 2c10(λ−
1

λ
) + 2c01(1−

1

λ3
) + 6c11(λ

2 − λ− 1 +
1

λ2
+

1

λ3
− 1

λ4
)

+ 4c20λ(1− 1

λ3
)(λ2 +

2

λ
− 3) + 4c02(2λ+

1

λ2
− 3)(1− 1

λ3
) (2.4)
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The stretch-stress data sets for each construct were fit to the 5-parameter Mooney-
Rivlin stress equation (derivative of the strain energy density function with respect to
strain) by using the curve fitting toolbox in MATLAB in order to obtain the material
constants. Next, equation 2.3 was differentiated with respect to the stretch ratio (λ),
the obtained material constants were placed in the differentiated equation 2.5, and the
tangential modulus was calculated for the static constructs tested in the redesigned clamps
at a specified stretch, as well as the nominal engineering stress and stretch values. The
MATLAB code can be seen in Appendix E.

TM = 2c10 +
2c10
λ

+
6c01 − 18c11 + 4c20(3λ

6 − 6λ+ 6)

λ4
+ 12c11λ+

24c11
λ5
− 12c11

λ3

− 6c11 − 12c20 +
4c02(2λ

2 − 9λ2 + 5)

λ6
+ 8c02 (2.5)

Figure 2.9: The 5-parameter Mooney Rivlin material model was determined as the best fit model to the
experimental stretch (x) vs stress (y) data and the material constants for each construct were obtained
using the Curve Fitting Toolbox in MATLAB. This figure shows an example of one of the static constructs
tested in the redesigned clamps
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2.4.3 Creating Regions for DIC Analysis

A box-shaped region of interest (ROI) was selected for each construct for DIC analysis,
excluding the clamp edge regions which contained loose Velcro fibers, as well as the SI
region (Figure 2.10). The focus of the analysis was on the tissue region around the SI.
This binary mask region was drawn using Photopea, an open-source online photo editor.

Figure 2.10: The rectangular shaped ROI mask drawn over the top of a construct for DIC analysis.
The ROI excludes the SI region and tissue regions near the clamps which contain Velcro fiber artefacts

The constructs were subdivided into right and left sides with respect to the center of the
SI, as well as top shoulder, bottom shoulder, and mid cap regions, also seen in Figure
2.11. To study the local strain patterns, the static and IS constructs were compared
investigating the shoulder regions versus the mid cap region on both sides of the SI. Plots
were generated in MATLAB by averaging the εxx and εyy values per pixel across the
constructs within these regions mentioned above with the origin located at the center of
the SI. The X and Y displacement and strain maps were also generated in Ncorr to give
a more visual and local representation of these plots. Furthermore, the average εxx and
εyy values of each of the regions shown in Figure 2.12 were calculated in MATLAB per
construct to investigate the mid cap and shoulder regions surrounding the SI. The left and
right edges of the constructs were excluded due to visible artefacts observed with DIC.
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Figure 2.11: Subdivided regions of the constructs for DIC analysis which include right and left sides
with the center of SI as the origin, top and bottom shoulders, and the mid cap region. The grey dotted
lines represent the right and left sides of the SI. The box region enclosed by the green dotted lines is
where the average εyy was calculated per image. The box extends from the top and bottom of the SI
and 20% away from the edge and SI. The right or left side was chosen per construct based on which side
displayed the most εyy field homogeneity within the region. The image number in which an average value
of 10% εyy in the green box was used for data analysis

Figure 2.12: The average εxx and εyy values were calculated per each region; 4,5: right/left of SI (mid
cap), 2,7: top/bottom of SI (shoulders), 1,3,6,8: outside shoulder regions
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2.4.4 Image Analysis Selection

Using the DIC output data acquired per construct after running analysis in Ncorr, the
image number in which an average of 10% εyy in the mid cap region (referred to as ε10%)
was determined per construct using MATLAB (region specified in Figure 2.11). This
was performed in order to minimize the effect of the the different clamps used on the
static constructs when looking at local strain behavior and tangential moduli. The image
number where ε10% occurred was used for the analysis of each construct. The image
number differed for each construct (Figure 2.13). This normalizing method allowed
a more direct comparison to be made at ε10%, which is approximately the maximum
amount of physiological circumferential strain experienced by the mid cap region in a
fibrous plaque [18].

Figure 2.13: Image # (15 Hz) vs average mid cap εyy until rupture. A red marker has been placed at
approximately ε10% for each construct. The image # of this location was used for analysis in order to
normalize the local strain fields and minimize the variables between the constructs

2.4.5 Finite Element Analysis Model: Illustrative Example

In order to give the reader an illustrative example of the expected local displacement
and strain patterns surrounding the SI when undergoing uniaxial loading, a simplified
finite element analysis (FEA) model was created in ABAQUS [Dassault Systèmes, Rhode
Island, USA]. This model was meant to solely demonstrate how pulling a material with a
centered hole in two opposite directions affects the local properties, focusing on the region
surrounding the SI. For simplicity purposes, the model was assumed to be rectangular,
two-dimensional, hyperelastic non-linear, homogeneous, isotropic, and incompressible.
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Hyperelastic models have been used often for modeling tissue due to the non-linear
behavior exhibited at high strains [19]. A few different hyperelastic material models
were fit to Treloar’s experimental uniaxial, biaxial, and planar test data for a rubber
material and analysed to see which material models were stable (i.e. Neo-Hookean,
Mooney-Rivlin) [20]. The Mooney-Rivlin isotropic hyperelastic material model was
chosen because it fit the data reasonably well up to 100% stretch and the model was
not stretched more than 30%. Half of a 6x15 mm construct was modeled with a 2 mm
hole located in the center. Symmetry was applied about the Y-Z plane. The model was
seeded with a seed size of 0.25 and CPS4 elements were used (4-node bilinear plane stress
quadrilateral). The model was fixed at a central node at the edge of the hole and a Y
displacement of 1 mm was applied to both a central node at the top and at the bottom of
the model, in opposite directions to represent uniaxial tensile testing. A standard static
solver was used and the X and Y displacement and strain fields were created.

2.4.6 Strain Measures

Logarithmic strain (true strain) is the default output variable in ABAQUS for nonlinear
material, and is especially used for large deformations as it calculates incremental strain.
Although this FEA model outputs logarithmic strain as the default strain measure, the
Green-Lagrangian strain measure seen in DIC analysis is a comparable measure for small
deformations [21]. Green-Lagrangian strain is less of an intuitive measure for modeling
as it is obtained from the deformation gradient and using it in constitutive equations can
introduce challenges when interpreting the results or material constants of the model [21].
Green-Lagrangian strain is a more optimal measure for DIC as it allows for discontinuous
analysis (i.e. cracks), accounts for any rigid body rotation, and provides more accurate
results based on the deformation tensors. The Green-Lagrangian strain equations used
in DIC analysis for the normal X, Y and shear XY directions can be found in Appendix C.

When investigating global mechanical behavior of the constructs, the Y actuator
displacement was presented which is proportional to the stretch through Equation 2.1.
Stretch is one of the most often used strain measures recorded in literature. Often it is
most convenient for researchers to normalize the strain data in order to characterize the
material.

Each measure of strain can be mapped to one another through the following equations
below, where stretch is represented by λ, logarithmic strain is represented by εLE, and
Green-Lagrangian strain is represented by εGL. Lo represents the original length and l
represents the final length.



21 CHAPTER 2. MATERIALS AND METHODS

λ =
l

Lo
(2.6)

εLE = ln(λ) (2.7)

εGL =
1

2
(λ2 − 1) (2.8)

2.4.7 Statistical Analysis

Statistical analysis was carried out between the static constructs (using the commercial
and redesigned clamps), as well as with the IS constructs, reporting the average εxx, εyy,
and εxy in the mid cap and shoulder regions. All statistical data were generated using
MATLAB. The p value<0.05 was used as the cutoff for statistical significance in this
study. The data sets for each sample were assessed for normality using the Shapiro-
Wilk test, as this test is appropriate for small sample sizes [22]. If p>0.05, the data was
determined as normally distributed. Then the data sets being compared were put through
Levene’s test for homogeneity of variances [23]. If the variances were homogeneous, then
an independent two-sample t test was used. If p<0.05 for the Shapiro-Wilk test, then the
data set was determined as not normally distributed and a non-parametric test of two
independent samples test was considered. Statistical analysis was not carried out if the
data set contained n<3.
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Results

3.1 Tissue Engineered Constructs

Collagenous constructs including a soft inclusion with both culture procedures were
successfully created. The constructs varied in compaction rate by day 21. Tissue
compaction in the X direction was observed to be much greater in the IS constructs
(approx. 45%) than in the static constructs (approx. 15%) (Figures 3.1 and 3.2). A large
percentage of compaction in the Z direction was observed for both types of constructs
(approx. 80%), however minimal compaction in the Y direction was observed for both
constructs (Figure 3.2).

Figure 3.1: Comparison of construct compaction on day 21 with different culturing protocol: a)
statically cultured construct showed less compaction in X direction b) IS construct showed more
compaction in X direction

22
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Figure 3.2: Quantitative comparison of static and IS construct compaction percentage and standard
deviation in the X, Y and Z directions (refer to coordinate system in Figure 3.1) on day 21. Note:
negative values represent shrinkage and positive represent expansion, dotted line represents no change

The SI’s were well integrated in the constructs by day 21 as cells of the fibrin-matrix
infiltrated all SI’s, irrespective of the loading protocol applied (Figure 3.3). The observed
gradient in cell number will affect the amount of collagen deposited going from the artificial
fibrous cap to the SI (mimicking the fibrous cap-lipid pool transitions seen in vivo) [2].
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Figure 3.3: Images taken with a Brightfield microscope on day 21, before mechanical testing, to observe
the collagen migration into the soft inclusion: a) static construct b) IS construct *Images courtesy of
Tamar Wissing

3.2 Global Mechanical Behavior

In this section, the results of the uniaxial tensile tests that were performed on the statically
cultured (n=4) and IS constructs (n=4) in the commercial clamps, as well as the static
constructs in the redesigned clamps (n=3), are presented. This section will report the
effect of straining protocol on global mechanical behavior for the static and IS constructs
tested in the commercial clamps, as well as the effect of the clamp redesign on the
mechanical behavior of the static constructs.

3.2.1 Effect of Straining Protocol: Static vs IS Constructs

The actuator Y displacement vs Y force measured in the IS and static tissue constructs
tested in the commercial clamps are plotted (Figure 3.4). These constructs exhibit a
comparable mechanical behavior pattern, with the exception of the varying maximum Y
force/Y displacement experienced before rupture (Y force ranging from approx. 1000-
2500 mN). Rupture at the clamp edge was seen in all constructs, except in 2 out of 4 of
the IS constructs in which rupture occurred near the SI.
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Figure 3.4: Y force vs actuator Y displacement plots of the IS and static constructs tested in the
commercial clamps until rupture. This plot is proportional to the nominal engineering stress vs strain
plot: Dotted curves represent the IS constructs, solid lines represent the static constructs, red represents
rupture which occurred at the clamp edge, black represents rupture which occurred near the SI

3.2.2 Effect of Clamp Design: Commercial vs Redesigned
Clamps

The actuator Y displacement vs Y force measured in all statically cultured tissue
constructs are plotted (Figure 3.5). This graph is proportional to the nominal
engineering stress vs strain plot. It was observed that the static constructs tested in the
commercial clamps all lead to rupture at the clamp edge, displaying a sudden decrease in
Y force at rupture, followed by a plateau and decrease again. This rupture pattern was
not observed in the static constructs tested in the redesigned clamps. Two out of three of
these constructs displayed a two-bump pattern, linked to the initial rupture on one side
of the SI (first bump) and the second rupture on the other side (second bump). The other
static construct tested with the redesigned clamp ruptured at the clamp edge resulting
in a sudden decrease in measured Y force. Moreover, a higher Y force at comparable
stretch values was observed in the static constructs tested in the redesigned clamps when
compared to the commercial clamps, most apparent after approximately 25% stretch
(250 µm actuator Y displacement). Accordingly, the maximum Y force values before
rupture were also approximately doubled for the constructs in the redesigned clamps,
and located at a lower stretch value than the commercial clamps.
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Figure 3.5: Y force vs actuator Y displacement plots of all statically cultured constructs until rupture.
This plot is proportional to the nominal engineering stress vs strain plot: Solid curves represent the
constructs tested in the redesigned clamps, dotted curves represent the constructs tested in the commercial
clamps, red represents rupture which occurred at the clamp edge, black represents rupture which occurred
near the SI

The calculated stretch ratios, nominal engineering stresses, and tangential moduli of
the static constructs tested in the redesigned clamps at the ε10% locations are listed
in Table 3.1. Refer to Appendix F for the code used to extract these values. One of
the three constructs was excluded from analysis due to an inadequate speckle pattern
applied, which is necessary to calculate the ε10% location with DIC in order to carry out
DIC analysis. A large difference was observed in tangential modulus between the two
constructs, approximately 2 MPa. The stretch and engineering stress values at the region
of ε10% for each construct was comparable.

Table 3.1: The estimated tangential moduli, engineering stresses and stretch ratios at the ε10% locations
for the static constructs tested in the redesigned clamps; TM10%= tangential modulus, σ10%= stress, λ10%
= stretch, Note: data does not include the static construct with the inadequate speckle pattern

Static (redesigned)
n=2

TM10% (MPa) 4, 2

σ10% (kPa) 75, 60

λ10% 1.05, 1.06
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The actuator Y displacement vs Y force measured in all 7 of the static and all 4 of the
IS tissue constructs are plotted until their rupture points (Figure 3.6). All constructs
demonstrated non-linear behavior. The commercial clamps displayed less steep curves as
well as lower maximum Y force when compared to the redesigned clamps, although they
reached higher stretch values overall. No significant difference was observed in mechanical
behavior between the static and IS constructs tested in the commercial clamps.

Figure 3.6: Y force vs actuator Y displacement plots of all static (black) and all IS (red) constructs
until rupture: solid lines represent the new clamps, dotted lines represent the commercial clamps. This
plot is proportional to the nominal engineering stress vs strain plot

3.3 Local Strain Patterns

Digital image correlation analysis was carried out on the images obtained during
mechanical testing for each of the constructs to investigate local strain patterns for the
different clamping and straining techniques, and how they may relate to rupture. A
normalizing method was used to select the images for analysis to allow a more direct
comparison between constructs. A simplified 2D hyperelastic finite element model was
created to serve as an illustrative example of what the expected displacement and strain
fields would look like when undergoing uniaxial tensile testing. Appendix D explains the
parameter selection analysis method in order to carry out DIC analysis.
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3.3.1 Finite Element Analysis Model: Illustrative Example

The displacement and strain field outputs of the simple hyperelastic FEA model were
generated (Figure 3.7). Symmetry was applied about the Y-Z plane. A gradient pattern
was observed in the X and Y displacement as approaching the SI. Higher X logarithmic
strain was observed at the top and bottom of the SI (extension), whereas lower Y
logarithmic strain was seen in these regions. Whereas, lower X logarithmic strain was
observed at the right and left sides of the SI (compression) and higher Y logarithmic
strain was seen at these regions. There is an apparent inverse pattern between X and
Y strain surrounding the SI. A symmetric positive and negative XY shear strain pattern
was also observed at the sides of the SI.
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Figure 3.7: Finite element analysis results of 2D hyperelastic model reported as logarithmic strain
(symmetry applied about Y-Z plane)
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3.3.2 Effect of Straining Protocol: Static vs IS Constructs

A few observations can be noted from the X and Y displacement and strain maps
generated via DIC analysis (Figure 3.8). It can be seen that the Y displacement field
shows symmetric behavior in both the static and IS constructs, as was also observed
in the FEA model. Furthermore, in both constructs, higher εyy (extension) was seen
at the left and right sides of the SI and a lower εyy was seen at the top and bottom
of the SI. High εyy values also occurred near both clamp edges. Overall symmetric
behavior can be seen in both constructs. An inverse trend for εxx was observed
in for both constructs, which agree with the FEA model results. On the top and
bottom of the SI, high εxx values (extension) were exhibited, whereas the right and
left sides of the SI exhibited negative εxx values (compression). The εxy behavior of
the constructs showed a comparable diagonal symmetric trend, especially surrounding
the SI region. One key difference between constructs was the X extension noticed
at the edges of the IS construct as opposed to compression observed in the static
constructs. There was also an apparent symmetric “C” shaped trend observed in the
IS constructs for εxx as opposed to the homogeneous behavior seen in the static constructs.
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Figure 3.8: X and Y displacement and strain maps at ε10% for a static and IS construct tested in the
commercial clamps
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All constructs behaved similarly to the examples shown above, with the exception of 2
constructs (1 IS and 1 static in commercial clamps) which did not follow the same X
displacement and εxx trends as the other constructs (Figure 3.9). One static construct
tested with the commercial clamps displayed a large gradient-like behavior in the X
direction and one IS construct exhibited a very different behavior than the other IS
constructs, as if it was shifted diagonally while undergoing mechanical testing.

Figure 3.9: Two constructs which displayed different behavior from the other constructs: a) εxx of a
static construct tested in commercial clamps (gradient-like) b) εyy of an IS construct tested in commercial
clamps (diagonally shifted behavior)

3.3.3 Effect of Clamp Design: Commercial vs Redesigned
Clamps

The strain pattern behavior of the static constructs tested in the commercial clamps and
redesigned clamps showed similar trends, with a few exceptions (Figure 3.10). Overall
symmetric behavior can be seen in both clamp designs, although the redesigned clamps
displayed more homogeneity throughout the construct, especially when looking at the
εyy behavior. Both clamps designs displayed compressive εxx behavior at the edges, not
observed in the IS constructs.



33 CHAPTER 3. RESULTS

Figure 3.10: X and Y displacement and strain maps at ε10% for two static constructs tested in the
commercial clamps (left) and redesigned clamps (right)
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3.3.4 Quantification of Local Strain Patterns

Additionally, X and Y average strain plots were generated across the mid cap and
shoulder regions for all constructs (Figure 3.11 shows an example of the IS construct
from Figure 3.8). It can be verified with these plots that the top and bottom of the SI
in the mid cap region experienced high εxx extension and the immediate left and right
sides of the SI experienced εxx compression. In the shoulder regions, this trend was also
observed, although the compression values were less. For the average εyy, the opposite
trend mentioned previously could be verified as well, where the top and bottom of the SI
in the mid cap region experienced low εyy extension and the immediate left and right sides
of the SI experienced a high εyy extension peak. It is apparent that within the shoulder
regions, the peak values were much less. The εxy also showed symmetric behavior about
zero, where an inverse trend is seen in the shoulders region surrounding the SI for the
right/left sides. Overall, symmetric behavior was observed in the constructs for the right
and left sides as well as the top and bottom shoulders. The remaining X and Y average
strain plots for all constructs can be seen in Appendix E and display similar trends as
previously mentioned.
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Figure 3.11: X and Y average strain plots running along the width of an IS construct, excluding the
SI for the mid cap and shoulder regions, subdivided into left/right and top/bottom regions. The normal
X and Y strains are presented in the first and second rows, respectively, as well as the XY shear strain
in the last row. The grey dotted lines enclose the left and right most side boundaries of the SI region
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The IS construct example previously shown was also used to compare the average εxx
and εyy in the different regions of the construct surrounding the SI (Figure 3.12, refer to
Figure 2.12 in the methods section for the selected regions). The inverse trend between
the left and right sides of the SI and top and bottom of the SI was apparent for the
εxx and εyy. The statistical comparison of these averages grouped for each region are
displayed in Figures 3.13-3.15. No statistical difference in average εxx between regions
and constructs was observed, with one exception. The shoulder regions of the static
constructs in redesigned clamps proved to have a statistically higher εxx than the static
constructs in the commercial clamps (p<0.05), which showed compressive behavior.
Similarly, the average εyy in the mid cap region of the IS constructs tested in the
commercial clamps was statistically higher than the εyy in the static constructs in the
commercial clamps (p<0.005), showing more εyy extension. Also, the average εxy was
statistically higher in the mid cap region of the static constructs (commercial clamps)
when compared to the static constructs (redesigned clamps) (p<0.05).

To summarize, for εxx, no statistically significant differences were found for the top/bottom
and left/right mid cap regions of the SI between the different groups analyzed. For εyy and
εxy, no statistically significant differences were found for the shoulder regions surrounding
the SI between the different groups analyzed. Statistical analysis was not carried out
if the total number of samples were too small (n<3), as was the case with the top and
bottom regions of the SI for the static constructs in the redesigned clamps, although the
plots were still presented.
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Figure 3.12: Average εxx (a), εyy (b), and εxy (c) from different regions of an IS construct (refer to
Figure 2.12 for corresponding regions); blue: right and left sides of SI in mid cap region, green: top and
bottom sides of SI in shoulder region, red: remaining shoulder regions, excluding edges
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Figure 3.13: Comparisons of average εxx between construct types and clamps used: a) left/right SI
in mid cap region b) shoulder regions, excluding edges c) top/bottom SI in shoulder region; Note: (R)
redesigned clamps, (C) commercial clamps *:p<0.05.
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Figure 3.14: Comparisons of average εyy between construct types and clamps used: a) left/right SI
in mid cap region b) shoulder regions, excluding edges c) top/bottom SI in shoulder region; Note: (R)
redesigned clamps, (C) commercial clamps **:p<0.005.
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Figure 3.15: Comparisons of average εxy between construct types and clamps used: a) left/right SI
in mid cap region b) shoulder regions, excluding edges c) top/bottom SI in shoulder region; Note: (R)
redesigned clamps, (C) commercial clamps *:p<0.05.

3.4 Rupture Behavior

The IS constructs tested in the commercial clamps demonstrated a variation in rupture
location, either rupturing near the SI (2/4) or at the clamp edge (2/4). The static
constructs tested in the commercial clamps all ruptured at the clamp edge (Figure 3.16).
It can be seen in the strain maps, that a high εyy (extension) on the right and left sides
of the SI is apparent in the construct that ruptured near the SI, but does not exist in the
constructs that rupture at the clamp edge. The region of highest εyy in these constructs
is located near the clamp edges. This may be a possible link to how εyy may relate to
rupture location.
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Figure 3.16: X and Y strain maps taken immediately before rupture observed during uniaxial tensile
testing: IS constructs tested in the commercial clamps show rupture near the clamp edges (2/4) and near
the SI (2/4), static construct in commercial clamps show rupture near the clamps only (4/4)

In the static constructs that were tested in the redesigned clamps, rupture was observed
near the SI in 2 out of the 3 constructs. A similar trend of maximum εyy occurs at the
location of rupture when ruptured near the SI (Figure 3.17). Similarly, this maximum εyy
is seen near the clamp region where the construct ruptured. A significant εxx compression
behavior was also observed at the location of rupture near the SI, as was also seen in the
IS constructs rupturing near the SI.
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Figure 3.17: X and Y strain maps taken immediately before rupture observed during uniaxial tensile
testing: static constructs tested in redesigned clamps show rupture near the SI (2/3) and clamp region
(1/3)



4
Discussion

The aim of this study was to create collagenous constructs, incorporate a soft inclusion,
and mechanically characterize them to aid in the development towards an in vitro
atherosclerotic fibrous cap model to systematically study plaque rupture mechanics.
These constructs were created with a fibrin gel containing HVSCs and either statically
cultured or subjected to uniaxial intermittent straining during culture. Uniaxial tensile
testing was performed using two different clamp designs to investigate the global
mechanical behavior, as well as local strain patterns preceding rupture using DIC.

4.1 Tissue Engineered Constructs

In this study, collagenous constructs were created according to previously established
static and dynamic (IS) cell culture protocols used for tissue engineered collagen-rich
heart valve constructs [8]. The protocol was altered to reflect the environment of an
atherosclerotic fibrous cap. Following these altered protocols, tissue engineered constructs
without a SI were previously created using static and intermittent straining protocols, as
these methods have been reported to improve and accelerate the alignment of collagen
fibers in the direction of loading [5]. The previously created constructs were subjected to
7 days of static culture and 14 days of straining. The stiffness values extracted for these
constructs ranged between approximately 0.2-5 MPa at 5% stretch, which was within the
range found in literature for carotid fibrous caps (approx. 0.5-5 MPa) [24]. However, the
ultimate tensile properties of these constructs were substantially higher when compared
to the scarce literature evaluating fibrous cap tensile strengths. To compensate for the
high strength behavior seen previously, this study altered the straining protocol to 14
days of static culture and 7 days of intermittent straining. Also, in this study, a SI (with
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stiffness of approximately 1 kPa) was introduced into the collagenous structure in order
to represent the mechanical properties of the lipid pool and to investigate the effect of
this substantially less stiff structure on the rupture mechanics of the construct. The SI
became well integrated within the collagenous environment, as seen in vivo, containing
even cell growth on all sides of the SI. Ultimately, this SI incorporated model could aid in
discovering the underlying principles behind plaque rupture mechanics. Due to the large
variation seen in vivo atherosclerotic plaque collagenous structure and the variety of
potential rupture mechanisms, future research should focus on better characterizing these
constructs and changing culture conditions to embrace the biological variance seen in vivo.

Dependent on the loading regime applied, various amounts of construct compaction
were observed at day 21. Approximately 50% compaction in the X direction (width)
was observed in the IS constructs when compared to the statically cultured constructs
which showed approximately 15% compaction (Figure 3.2). Accordingly, there was a
large amount of Z compaction (thickness) observed for both the static and IS constructs
(approx. 80%). As expected, minimal Y compaction (length) was observed in all
constructs as the tissues were constrained in this direction during culture. The significant
difference in X compaction could signify a substantial effect of straining on the micro-
structure of the constructs. This increase in compaction seen in the IS constructs could
possibly be caused by an increase in cell-to-cell interactions and tissue reorganization
along the edges of the construct when uniaxial strain was introduced [25]. The similar Z
compaction behavior between constructs reveals that the uniaxial straining did not have
an impact on the thickness. The large amount of Z compaction observed may be due to
the cell matrix forces increasing in time as the fibrin matrix degrades [25].

4.2 Global Mechanical Behavior

4.2.1 Effect of Straining Protocol: Static vs IS Constructs

Interestingly, no significant difference was observed in global mechanical behavior
between the static and IS constructs tested in the commercial clamps (Figure 3.4). The
large difference in X compaction (width) between these constructs did not appear to
significantly effect their force-stretch curvature behavior, as was observed in previous
experiments. Additionally, the maximum Y force before rupture consistently varied in
both constructs, ranging from 1000-2500 mN. The similar force-stretch curvature behavior
between constructs could be explained by the amount of time that the IS constructs
were strained for which may not have been sufficient to create a substantial difference
in micro-structure compared to the static constructs. The variation in maximum Y
force could indicate variation occurring on the microscopic-scale which could be affecting
the global rupture behavior. Also, any variation in micro-structure near the clamp
edge, where rupture most often occurred, could have an affect on the global mechanical
behavior of both constructs.
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4.2.2 Effect of Clamp Design: Commercial vs Redesigned
Clamps

In order to mechanically characterize the constructs, ideally the clamping technique
should have no effect on the mechanical behavior. The static constructs in the commercial
clamps displayed consistent rupture behavior near the clamp edge, demonstrating a
sudden decrease in Y force, remaining constant, and then dropping in Y force again
(Figure 3.5). Due to rupture occurring consistently at the edge of the commercial clamps
during testing, redesigned clamps were created in which 2 mm of tissue near the Velcro
edges were gripped onto each side to further improve the load transmission from clamp
to tissue. Observations showed a consistent two-bump sudden decrease rupture behavior
in the static constructs tested in the redesigned clamps, not seen with the commercial
clamps. These bumps appeared to be linked to the initial rupture on one side of the
SI (first bump) and the second rupture on the other side (second bump), successfully
producing consistent rupture at the site of the SI. Additionally, it was observed that the
static constructs tested in the redesigned clamps as opposed to the commercial clamps
displayed higher Y forces at comparable stretch (Figure 3.5).

The consistent rupture mechanical behavior in the static constructs tested with the
commercial clamps could indicate that the fibers in the region near the clamp edge
held on for some amount of stretch until a larger rupture occurred. This could be
linked to an increase in micro-failure occurring at this region and subsequently a gradual
decrease in maximum Y force. Contrarily, the clear and consistent two bump sudden Y
force decrease rupture pattern observed in the redesigned clamps could denote a more
structured mid cap region with higher maximum strength properties. The two bump
behavior was visually linked to rupture occurring on one side of the SI, followed by the
other side soon after. This behavior could be related to the collagen composition in the
constructs surrounding the SI. The fact that the constructs do not rupture near the
clamp edge in the redesigned clamps shows an improvement in load transmission to the
tissue. Furthermore, a larger slope in force-stretch was observed with the redesigned
clamps when compared to the commercial clamps, therefore clamp redesign may have a
large effect on the mechanical behavior observed.

Interestingly, the experimental data of the static constructs tested in the redesigned
clamps consistently followed a 2-curvature non-linear curve observed while curve fitting
(Figure 2.9), which was unlike the behavior of other constructs tested in the commercial
clamps. A consistent strain hardening behavior (increase in force needed to stretch
construct) was observed until approximately 5% stretch, after which a gradual strain
softening behavior was seen (decrease in force needed to stretch construct). Contrarily,
the commercial clamps consistently followed a 1-curvature non-linear curve (solely strain
hardening behavior), which also reflects the behavior seen in literature for human plaques.
Strain hardening behavior is often observed in biological soft tissue due to cell-matrix
stiffening interactions which increase with stretch. This strain softening behavior in
the redesigned clamp could possibly be due to an increase in gradual fiber micro-failure
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occurring after approximately 5% stretch. This behavior is not seen in human plaques
possibly due to a difference in structural fiber strength. Due to the consistency in
behavior, further investigation is needed. It can be hypothesized that the redesigned
clamps improved the transfer of tissue displacement, leading to more homogeneity and
reported the actual stretch occurring in the region of interest (mid cap region), when
compared to the commercial clamps. The commercial clamps reported higher stretch
values which may not accurately reflect the actual stretch occurring in this region. This
could explain why the strain softening behavior was not seen with the commercial clamps,
as this effect occurred at 5% stretch in the mid cap region and may not have been captured
by the commercial clamps before rupture occurred. Due to this 2-curvature behavior in
the static constructs with the redesigned clamps, in order to extract the tangential moduli,
the 5-parameter Mooney-Rivlin material model best fit the data.

4.2.3 Comparison to human atherosclerotic fibrous caps

In this study, the stiffness values for the constructs tested in the commercial clamps
were not reported due to possible artefacts occurring near the clamp region. However,
the tangential moduli were extracted from nominal global measurements for the static
constructs tested in the redesigned clamps in order to get an idea of their stiffness values
(Table 3.1). The stiffness values reported for the static constructs tested in the redesigned
clamps were approximately 2 MPa and 4 MPa at 10% stretch. These values are within the
wide range found in literature for carotid atherosclerotic fibrous caps ranging from 0.5 to 5
MPa at 10% stretch [24]. This two-fold difference in stiffness from the two constructs can
be attributed to the fact that the initial average thickness calculated for the constructs
had a two-fold difference, which affected the nominal stress reported, and therefore the
tangential moduli as well. This difference could have been caused by measurement error,
as the boundaries of the constructs were at times difficult to distinguish, therefore the
measuring procedure could be further optimized. These reported values should be read
with caution as the sample size was also small due to experimental access limitations. The
ultimate tensile strength values were not reported in this study due to possible differences
in local tissue thickness which would not accurately reflect the local maximum tissue
strength. When converting from global to local scale, a good command of the current
cross sectional area is necessary.

4.3 Local Strain Patterns

4.3.1 Effect of Straining Protocol: Static vs IS Constructs

Using DIC, similar trends were observed in the εxx and εyy patterns around the SI in
both the static and IS constructs tested in the commercial clamps at ε10% (Figure 3.8).
εxx compression was experienced by the SI left and right sides, as well as εxx extension at
the top and bottom of the SI. An inverse trend for the εyy was observed, with high εyy
extension at the left and right of the SI and low εyy extension at the top and bottom.
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However, the largest difference between the constructs was that the εxx pattern in the
IS constructs appeared to follow a symmetric “C” shaped compression trend going from
clamp to clamp, and extension occurred at the edges. This differed significantly from
the εxx pattern seen in the static constructs where homogeneous εxx behavior was seen
throughout the construct, with compression observed at the edges. Additionally, the IS
constructs showed a statistically significant higher εyy extension in the mid cap region
when compared to the other constructs.

The compressive behavior on the sides of the SI show that there is compaction occurring
on the sides of the constructs moving towards the SI, which is the expected behavior shown
in the FEA model for a material undergoing uniaxial tensile testing. If incompressibility
is assumed and the material is stretched in one direction, compaction is expected in the
orthogonal direction. This concept can also explain the interesting inverse trend observed
between εxx and εyy behavior surrounding the SI. The high εyy extension at the left and
right of the SI could be due to the parallel fiber alignment in the direction of stretch in
which the SI elongates. This interface between the SI and tissue is important to investigate
as it may exhibit stress/strain concentrations due to the difference in stiffness properties.
Furthermore, the difference in εxx patterns could be due to the fact that there is more
cell-to-cell force interactions occurring in the IS constructs because it is more developed
than the static constructs. Accordingly, the IS constructs showed a statistically significant
higher εyy extension in the mid cap which could also be due to a more structured collagen
architecture in this region, leading to stiffer local mechanical properties (Figure 3.14).
The unique differences in X displacement and strain behavior observed in two constructs
(one static and one IS) could possibly relate to any slack present in the construct before
testing due to either how they were loaded into the clamps or their composition (Figure
3.9). Further histology analysis is necessary.

4.3.2 Effect of Clamp Design: Commercial vs Redesigned
Clamps

The DIC strain patterns for the static constructs tested in the commercial and redesigned
clamps were overall comparable and followed a similar pattern, surrounding the SI, to
the constructs mentioned in the previous section (Figure 3.10). However, the static
constructs in the redesigned clamps showed more homogeneity within the mid cap region,
specifically for εyy. Furthermore, the εxy in the mid cap region for the static constructs in
the redesigned clamps demonstrated to be statistically lower than the static constructs
in the commercial clamps (Figure 3.15).

The increase in homogeneity displayed in the static constructs with the redesigned
clamps indicates better load transmission from the clamp to tissue during testing. The
lower εxy seen in the mid cap region for the static constructs in the redesigned clamps
may also support this notion of improved load transmission as the mid cap region of the
construct may be more sensitive to shear strain effects.
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The regions of ε10% determined by DIC are located on the global mechanical behavior
plots for all of the constructs in Appendix E (Figure E.1). The fact that there is a large
variation in these locations for all constructs tested in the commercial clamps, especially
located at higher stretch than the redesigned clamps, further supports the notion that
the commercial clamps could be greatly effecting the actual global mechanical behavior
reported for the area of interest (mid cap region). This location on the constructs tested
in the redesigned clamps varies less.

4.4 Rupture Behavior

In this study, the IS constructs tested in the commercial clamps varied in rupture
location, either occurring at the clamp edge or near the SI (Figure 3.16). The static
constructs tested in the commercial clamps all ruptured at the clamp edge and 2 out of
3 of the static constructs tested in the redesigned clamps ruptured near the SI (Figure
3.17). Regions of high εyy extension near the clamp area were observed in the constructs
that ruptured in this region. Similarly, high εyy extension and εxx compression occurred
near the rupture location in the constructs that ruptured near the SI. The increase in
the mid cap εyy extension showed statistical significance in the IS constructs (commercial
clamps) when compared to the static constructs (commercial clamps) (Figure 3.14).
Furthermore, the εxy seen in all the constructs leading to rupture demonstrated a
consistently symmetric pattern surrounding the SI, in which the positive and negative
values on each side of the SI equated to approximately zero.

The increase in the mid cap εyy extension in the IS constructs (commercial clamps)
when compared to the static constructs (commercial clamps) could be due to a more
structured mid cap region in the IS constructs, which may contain stronger local
mechanical properties than the global behavior reported (affected by the inadequate
load transmission). This demonstrates the importance of clamping design on the tissue
constructs when performing mechanical testing. The consistent symmetric εxy behavior
surrounding the SI indicates fairly symmetric collagen composition (i.e. orientation,
amount) within the constructs.

Using the strain pattern information discovered in this study surrounding the SI leading
to rupture could translate to clinical measurement in order to predict plaque rupture. For
example, the increase in εyy extension found at the rupture locations near the SI can be
representative of the circumferential strain experienced in the fibrous cap. Similarly, the
εxx compression found at the rupture locations near the SI can be representative of the
radial strain. By measuring high circumferential strain and compressive radial strain near
the lipid pool of a vulnerable plaque using imaging techniques, such as ultrasound, rupture
prediction strain fingerprints can be made. Although this is a step in the right direction,
a complete strain fingerprint is necessary. Inflation testing of TE circular cross sections,
representative of human plaque cross sections, could also supply additional mechanical
property data. This atherosclerotic in vitro disease model could be used in pharmaceutical
intervention to study drug delivery to suppress inflammation, decreasing rupture risk.
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4.5 Limitations

Due to the COVID-19 pandemic and limited resources available, this study contained
low sample sizes. Additionally, inter-experimental differences might have led to some
variation in the analysis, as the data taken from previously tested constructs were used in
this study as well, and could have also led to some variation in the analysis. Furthermore,
assumptions and estimations were made while measuring the initial and final dimensions
which may have an effect on the final results reported, although the measure error is
expected to be consistent between all samples.

Many of the observations made with the commercial clamps could be explained due to
the fact that the redesigned clamps may be more suitable for gradually transferring the
forces from the clamp to the tissue of interest (mid cap region) during testing. It is
hypothesized that this region of tissue, located near the clamp edge in the commercial
clamps, contains less amount of structured collagen when compared to the center of
the construct (mid cap region) due to it being a transition region into the Velcro.
However, this hypothesis must be confirmed with collagen histological analysis (i.e.
orientation, amount). This potentially less structured region could cause micro-structural
slippage to occur in the commercial clamps due to inadequate load transmission, in turn
causing more heterogeneity to occur in the mid cap region where the ε10% is determined.
Contrarily, this ε10% region in the redesigned clamps displayed homogeneous behavior,
possibly linked to the differences in mechanical behavior observed between clamp designs.

Due to the comparable mechanical behavior observed between the static and IS constructs
tested in the commercial clamps, testing the IS constructs in the redesigned clamps and
investigating the collagen composition (i.e. fiber orientation, amount, type) between
constructs is recommended as the next step before considering adjusting the straining
protocol. The global mechanical behavior of the commercial clamps may be reporting
behavior that is largely effected by this possible micro-structural slippage occurring near
the clamp-tissue interface.

In this study, the nominal engineering stress was calculated in order to report the
tangential moduli, however tracking the change in thickness during mechanical testing
and reporting Cauchy (true) stress in the future is recommended as tissue exhibits
some compressible behavior, although in this study incompressibility is assumed when
extracting the tangential modului. This could be done by using a microscope or mirror
which would allow the visualization of the tissue thickness and therefore the true stress
could be determined. Furthermore, linking the true stress to the local strain regions
determined by DIC analysis could provide a more representative mechanical behavior
measure during testing, largely due to the heterogeneity occurring within the construct.
However, the two-dimensional DIC used in this study has its own limitations for a
three-dimensional construct. It does not account for possible tissue deformation and any
micro-structural failure that may be occurring below the surface of the tissue, therefore
three-dimensional DIC should be considered.



50 CHAPTER 4. DISCUSSION

Regardless of these limitations, the findings found in this study regarding the mechanical
behavior and local strain fields of the TE constructs can be used to further investigate how
to successfully replicate the mechanical structure of an in vitro atherosclerotic fibrous cap
model to study plaque rupture mechanics. By successfully and consistently generating
rupture at the site of the SI in this study, future tests can be performed to mechanically
characterize the constructs with minimal clamping effects.



5
Concluding Remarks

5.1 Conclusion

The main findings of this study are further elaborated below based on the aims of this
study.

1. Create TE collagenous constructs containing a SI subjected to different straining
protocol during culture:
Fibrin-based gel constructs containing HVSCs were created which successfully
began to produce their own collagenous matrix. A soft inclusion was incorporated
successfully.

2. Subject the constructs to mechanical testing and investigate their global mechanical
behavior leading to rupture:
The different straining protocol led to different compaction behavior, however, this
difference in compaction behavior did not effect the global mechanical behavior of
the constructs significantly when tested in the commercial clamps. The redesigned
clamps displayed a consistent two bump rupture pattern correlating to rupture near
the SI, as well as higher measured force at comparable stretch, not seen with the
commercial clamps. Additionally, the redesigned clamps decreased the chance of
rupture near the clamp edge as seen in the commercial clamps.

3. Investigate local strain patterns of the constructs undergoing mechanical testing:
The static and IS constructs tested in the commercial clamps differed in εxx patterns,
as the static constructs displayed more homogeneity throughout the construct and
compressive behavior at the edges, whereas the IS constructs exhibited a symmetric
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“C-shaped” compressive pattern and extension at the edges, signifying a possible
difference in micro-structure. The redesigned clamps created for mechanical testing
demonstrated an improvement in the testing method for the TE constructs when
compared to the commercial clamps by exhibiting a better load transmission from
clamp to tissue, by creating more homogeneous strain distribution within the region
of interest and leading to rupture more often near the SI.

4. Investigate rupture behavior of the constructs:
DIC analysis demonstrated that high εyy values occurred at the rupture location
in both the redesigned and commercial clamps, possibly demonstrating a linkage
between high εyy extension behavior and rupture location.

5.2 Future recommendations

The following recommendations are based on the results of this study:

1. Use the redesigned clamps to study all constructs:
It is recommended to perform more testing with the redesigned clamps in the future,
as the sample size was low in this study. However, the redesigned clamps appeared to
better transfer the load from the clamps to the tissue and successfully led to rupture
near the SI more often. By imaging the region of possible micro-structural slippage
in the commercial clamps near the clamp edge, we can get a better understanding
of what is happening in that region and why rupture consistently occurred there.

2. Perform collagen histology to link mechanical properties to collagen structure:
Ultimately, understanding how collagen content (i.e. amount, types) and structure
(i.e. orientation) relates to the local and global mechanical properties of the
constructs is the overall goal of this project in order to create an in vitro
atherosclerotic fibrous cap model to study plaque rupture. The original plan of this
study was to relate collagen histology and mechanical properties of these constructs,
however, due to the pandemic, histology could no longer be performed. It would
be interesting to further investigate the region of tissue near the commercial clamp
edge, which was assumed to contain less structured collagen when compared to the
center of the construct, as it acts a transition region into the Velcro.

3. Increase the number of samples for statistical analysis:
The number of samples in this study were few and different variables were introduced
as well to optimize mechanical testing, therefore the power of the statistical analysis
performed was low. By increasing the number of samples and decreasing the number
of variables, more reliable statistics can be achieved between the constructs.
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4. Include different straining protocol during culture:
This study included statically cultured control constructs as well as intermittently
strained constructs, which were subjected to 2 weeks of static culture and 1 week
of intermittent uniaxial straining (see Appendix B). This protocol can be modified
to also include continuous straining as this has demonstrated to increase collagen
synthesis, remodeling, and maturation [26]. The number of weeks of culture
can also be increased as this has shown to increase collagen concentration [5].
Additionally, the shape of the loading post where the fibrin-based gel was seeded
in the Flexcell system can be altered to introduce a gradient-like straining during
culture, which can better reflect the collagen structure and composition found
in human atheroma fibrous caps. Also, by including off-centered soft inclusion
constructs in future experiments, the effect of distance from the soft inclusion to
the lumen edge on rupture behavior can also be investigated.

5. Add other biological factors to the model during culture:
By systematically adding other biological factors that are known to contribute to
plaque rupture, such as macrophages, calcifications, etc, the model can become more
realistic and complex.
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A
Protocols

Appendix A.1 includes the protocol used to create the fibrin-based TE constructs and
Appendix A.2 includes the mechanical testing protocol used.

A.1 Creating Fibrin-based TE Constructs

TU Eindhoven (Gemini-Zuid 4.105), 06.03.2020, Sheila & Tamar

Materials

- Fibrinogen

- 0.05% TRYPSIN/EDTA

- Medium (previously made)

- PBS (sterile)

- 2x tweezer (sterile)

- Big petri dishes (sterile)

- Big beaker glass

- Culture plates (sterile)

- Eppendorf tubes and holder (sterile)

- 200 µl / 1000 µl pipets and tips

- 50 ml tubes

- T75 flasks

- Thrombin (100 u/ml)
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- Ice

- 3x syringe

- 3x needle

- 3x 0.2 µm filter

- Pipet boy

- Eppendorf holder

- Extra needles

- ε-amino caproic acid (10 mg/ml)

- Vitamin C (0.25 mg/ml)

- Nucleometer

- Solution A and B (near nucleometer)
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Methods

Step 1. Preparations

1. Obtain the culture plates with the pasted Velcros

2. Obtain the sterilzed PDMS bars created

3. Obtain the fibrinogen, 0.05% TRYPSIN/EDTA, and medium and allow them to
adapt to room temperature

Step 2. Cell Counting

1. Wash each of the four T150 flasks with 10 ml PBS (2x) to remove the proteins that
inactivate the TRIS/EDTA using a vacuum pipette

2. Add 7 ml TRYPSIN-EDTA per flask in a vertical position

3. Incubate flasks in horizontal position at 37 degrees in the incubator for 7 minutes
(make sure cell side is covered properly with the TRYPSIN-EDTA solution)

4. Remove the flasks and hit them from the sides to loosen all cells

5. Check under the microscope to verify that the cells appear rounded (loosened)

6. Add 14 ml of medium per flask, mix well by pipetting up and down, and transfer
to a sterile T75 flask

7. Divide the contents in the T75 over 50 ml tubes

8. Take about 200 µl for cell counting using the nucelometer (follow the protocol of
the nucleometer):

(a) Transfer 50 µl of the cell suspension to a new Eppendorf tube to count the
cells

(b) Add 50 µl of solution A and vortex for 2 seconds (permeabilizing the cell
membrane)

(c) Add 50 µl of solution B and vortex for 2 seconds (stabilizing the permeabilized
cells)

(d) Take a cassette, suck the solution up, and place the cassette into the
nucleometer. This will count both dead and alive cells by binding propodium
iodide to the cell’s DNA. To make sure the number of dead cells are less than
5x103, repeat without adding solutions A and B. If this holds true, proceed
with the next step.

(e) Record the total number of cells counted with the first measurement (cells/ml),
factoring in the diluted solution (ml)

(f) Calculate how many constructs can be created with the amount of cells counted
(N = cells/675,000), where 675,000 cells/construct

9. Centrifuge the 50 ml tubes at 1200 rpm for 5 minutes (acceleration and braking
speed 4)



60 APPENDIX A. PROTOCOLS

10. Remove the medium with a vacuum pipette

11. Add 1-3 ml of medium and loosen the cell pallet with a 1 ml pipette

12. Transfer all cell suspensions to one tube and wash the remaining tubes with 5ml
medium per tube to collect all cells that are left

13. Centrifuge the tube at 1200 rpm for 5 minutes (acceleration and braking speed 4)
and place it on ice

Step 3. Prepare Thrombin and Fibrinogen Solution

1. Obtain the thrombin solution (100 u/ml) and dilute to 10 u/ml

2. Calculate how much thrombin (10 u/ml) solution is necessary (N * 225 µl = ml
thrombin), make slightly more always

3. Put the thrombin solution on ice

4. Remove the supernatant of the cells after centrifuging (previous step 13)

5. Add 1 ml of thrombin solution, tilt the 50 ml tube, and carefully loosen the cell
pallet with a 1 ml pipette

6. Calculate the cell pallet volume, make sure you add the correct amount of thrombin

(a) Transfer with the 1 ml pipette, the cell suspension into a clean 50 l tube

(b) Measure how much volume you have more (cell pallet volume)

7. Add the rest of the necessary thrombin solution (minus the 1 ml), mix the cell
suspension properly, and place it on ice

8. Calculate the volume of thrombin (µl) per construct (225 µl * N + cell pallet volume
= total volume (µl), divide this total volume by N)

9. Calculate the total volume for each construct (thrombin volume + 225 µl = total
volume per construct)

10. Obtain the room temperature fibrinogen (12.65 mg/ml)

11. Measure the amount of fibrinogen (mg) needed by taking the same amount of
fibronogen as the thrombin (ml), but adding at least 1 ml extra (ml* 12.65 mg/ml
= mg fibrinogen). Dissolve the fibrinogen (mg) into the appropriate volume of
medium, calculated above, under warm water

12. Immediately filter the solution through a 0.2 µm filter with a syringe (renew filter
after 1.5 ml) and place it on ice

Step 4. Make the Fibrin-based Gels and Seeding

1. Add the PDMS pieces to a clean large Petri dish and use a sterile tweezer to place
two on both sides of the Velcro’s (make sure they are stuck so that no fibrin will go
underneath it)

2. Pipette out remaining water (PBS) to make the PDMS bars stick better
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3. Take a clean Eppendorf tube per construct. Add the correct amount of the
thrombin-cell solution (previous step 8- volume of thrombin per construct) and
place it in the Eppendorf tube

4. Get a 100-1000 µl pipette and pipette 225 µl of fibrinogen in the pipette tip. Switch
the volume to 492.9 µl (previous step 8- total volume per construct) and press out
the air before mixing it into the thrombin-cell suspension to prevent air-bubble
formation

5. Pipette 2x up and down without introducing bubbles and divide the solution over
the half of the Velcro, the middle compartment, and the other half of the Velcro
(make sure everything is well divided and there are no bubbles. Do this fast as
everything clots really easily. Use a sterile needle to remove bubbles)

6. Repeat this for the other constructs and place them in the incubator for at least 30
minutes

7. Make medium with fresh Vit C and ε-ACA (N * 5 ml = total volume of medium
(ml), always make a little extra)

8. Weigh the appropriate amount of Vit C (0.25 mg/ml Vit C * total volume of medium
(ml) = mg Vit C)

9. Dilute Vit C to 25 mg/ml (mg Vit C / 25 mg/ml = ml medium)

10. Filter the diluted Vit C using a 0.2 µm filter

11. Calculate the amount of ε-ACA needed (1 mg/ml * total volume of medium (ml) =
mg of ε-ACA)

12. Weight some amount of ε-ACA and record the value

13. Dilute the ε-ACA in 3 ml (record mg/ml of ε-ACA)

14. Calculate the ml of ε-ACA needed for the mg calculated above

15. Combine the calculated amounts of Vit C, ε-ACA, and normal medium (total volume
of medium - Vit C - ε-ACA)

16. Make a photo of your constructs and add the medium to the wells and refresh
medium every 2-3 days (remove the PDMS pieces with the second medium change)
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A.2 Mechanical Testing

TU Eindhoven (Gemini-Zuid 4.105), 27.03.2020, Sheila & Tamar

Materials

- BioTester, Biaxial test system from CellScale

- Calibration spring (5 N)

- Two 5 N load cells

- Tweezers

- Well plate filled with PBS

- Large beaker filled with PBS

- Ice

- Coarse graphite sandpaper

- Cotton swabs

- Two clamps (redesigned)

- 1mm thick double sided foam tape

- Double sided tape

- Screwdriver for M2.5 screws

- Fine sandpaper (P400)

- Cutting plate

- Microtome blades

- Scissors

- Microscope (Keyence)

- Hard drive to collect data
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Methods

Step 1. Preparations

1. Pour PBS into the black fluid chamber to fill it up

2. Turn on the tensile tester machine and the temperature with the two black switches
on the machine

3. Turn on the PC and start the LabJoy program

4. Reset the actuators

5. Create a new protocol for testing by selecting “Collect New” under “File”

6. Set parameters to the following:

For pre-conditioning at 10% stretch:

(a) Set “Control Mode” to “Displacement” for both X and Y Axis

(b) Set “Control Function” to “Ramp” for both X and Y Axis

(c) Set “Stretch Magnitude” to “0%” for X Axis and “10%” for Y Axis

(d) Set “Preload” to “Not Applied” for both X and Y Axis

(e) Set “Stretch Duration” to “3 S” and “Recovery Duration” to “3 S”

(f) Set “Repetitions” to “10”, “Data Output Frequency” to “15 Hz”, and “Image
Output Frequency” to “15 Hz”

For stretch until failure at 100%/min:

(a) Set “Control Mode” to “Displacement” for both X and Y Axis

(b) Set “Control Function” to “Ramp” for both X and Y Axis

(c) Set “Stretch Magnitude” to “0%” for X Axis and “300%” for Y Axis

(d) Set “Preload” to “Not Applied” for both X and Y Axis

(e) Set “Stretch Duration” to “180 S” and “Recovery Duration” to “10 S”

(f) Set “Repetitions” to “1”, “Data Output Frequency” to “15 Hz”, and “Image
Output Frequency” to “15 Hz”

7. Zero the load cells

8. Calibrate the load cells:

(a) Click on Tools>Advanced>Load cell calibration

(b) Enter the correct spring K value under the “Spring K” field (found on selected
spring package)

(c) Lower the PBS chamber and put the calibration springs into place

(d) Zero the load cell
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(e) Move the actuators (with the jog buttons) until they are spaced so that the
calibration spring can be set onto the posts without applying any significant
load (approx 25000 µm x 25000 µm)

(f) Set the calibration spring on the posts so that they are in a stable, horizontal
position

(g) Click on Tools>Advanced>Load cell calibration and preload the spring with
the preload specified on the box (by moving actuators)

(h) Click on “Run” and wait for calibration to complete

(i) The number “A” which shows in the main dialogue box after calibration is
finished is the ratio of the current calibration value to the previous one. “A”
should be between 0.99 and 1.01, if not, restart the system and calibrate again

9. Define new zero point of the actuators (for redesigned clamps):

(a) Click on Tools>Advanced>Centre Position Calibration

(b) A dialogue box will show that states “The Operation will Define The Current
Position as the Center for the X and Y axes. Do you want to Continue?” Select
“Yes”

(c) Reset the actuators

(d) Select “Advanced then move to Centre” from the tools menu. The dialogue
box will say “This Operation Requires The BioRakes to be removed. Do you
want to Continue?” Select “Yes”

(e) When the actuators stopped, place 2 clamps on the Y-axis

(f) Move the actuators (using the jog buttons) until the clamps almost touch each
other (with the “mirror matching” button selected, not the “independent”
button)

(g) Select Tools>Advanced>Centre Position Calibration. This is the last “Centre
Position Calibration”. The dialogue box will state “The Operation will Define
The Current Position as the Center for the X and Y axes. Do you want to
Continue?” Press “Yes”

(h) Reset the actuators

10. Clamp preparations:

(a) Use the microtome blade to cut the double sided foam tape, double sided tape,
and sandpaper (P400) with the following dimensions per construct: 4x (15 mm
x 1.5 mm) sandpaper and double sided tape, 4x (15 mm x 5 mm) sandpaper
and double sided foam tape

(b) Refer to Figure A.1 to properly prepare the clamps. Stick the foam tape pieces
on the center edges of the bottom and top clamps. Stick the smaller pieces
of sandpaper directly on top of the foam tape. Stick the larger double sided
tape next to the foam tape on the clamps. Stick the larger sandpaper pieces
directly on top of the tape.
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Figure A.1: How to properly paste the sandpaper onto the clamps for gripping the constructs during
tensile testing *Image courtesy of Tamar Wissing

11. Placing the constructs into the clamps:

(a) Use a tweezer with a pointy tip to carefully loosen the Velcro from the bottom
of the well plate. Make sure that you do not damage your sample (only touch
the Velcro) and place it in a well plate with PBS on ice (keep the samples as
much as possible on ice before the test to prevent that they deteriorate)

(b) Place the construct on the sterilized blue cutting plate and make an image
above to measure the starting size in an unconstrained configuration (make
sure you record which construct each image corresponds to)

(c) Place the sample on a clean tissue to dry it a bit and apply graphite particles
using the coarse sandpaper and cotton swabs

(d) Place the sample on the clamp and plac the other part of the clamp on top
(the Velcro should be positioned after the foam tape so that only the tissue
comes into contact with the thicker part of the sand paper, as seen in Figure
A.2)
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Figure A.2: Proper positioning of the construct in the redesigned clamps. The soft inclusion should
still be visible. The Velcro should fit snugly into the groove. *Image courtesy of Tamar Wissing

(e) When the constructs are placed properly (the soft inclusion is visible), screw
the clamps with a torque screwdriver set to 10cNm until it clicks

12. Measure and record the construct thickness:

(a) Shift the microscope to a horizontal position by removing the pin in the back
of the microscope and carefully lowering it to the side. Pull on the handle on
the back to be able to move the microscope the last couple of degrees to a 90
degrees angle.

(b) Change the magnification of the microscope to 20 or 30x.

(c) Place the loaded clamps in front of the camera and focus on the construct side.

(d) Measure the thickness (go to measure in the menu and draw measurement
lines, approximately 10 over the full length of the construct, as seen in Figure
A.3)
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Figure A.3: Measure and save 10 thickness values across the construct on both sides *Image courtesy
of Tamar Wissing

(e) Save the images with the measurements (.jpg) and the CSV file

(f) Remove the images from the computer with an USB stick

(g) Turn the sample with the clamps 180 to measure the other side (side 2) in the
same way

Step 2. Execute the Uniaxial Tensile Testing

1. Mount the construct into the tensile tester:

(a) Restart the program and click on File>Collect new

(b) Select the “Starting Point” template if done previously

(c) Move actuators to specified size

(d) Carefully place on each Y axis actuator, one clamp with the construct in the
middle

(e) Zero load the cells

(f) Use the jog buttons to unfold the sample without stretching it. If the Y force is
going up to 5 mN or above you should stop as you start stretching the sample.
Go back to 0 mN force.

(g) Fully raise the chamber to submerge the sample in the warm PBS
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(h) Unfold the sample once more with the jog buttons until the Y-force goes up. Go
back to 0 (Make sure that you focus on the construct. The graphite particles
should be clear and the lighting should be good. You want to prevent bright
spots of the lighting in the picture)

(i) Zero load the cells

2. Perform the uniaxial tensile testing:

(a) When both Fx and Fy are approx 0, execute the test by pressing the “Play”
button

(b) Stop when the Y-force exceeds 100 mN

(c) Go to the data excel sheet of the starting point regimen just run and select
one column of the data sheet. Go to data, text to columns, delimited, comma,
next, finish to get all data in separate columns.

(d) Note the Y-distance where the specimen exceeded the 40 mN and start a new
regimen via File-Collect new

(e) This time you need to run a different template: real measurement (if previously
created)

(f) Specify the Y-distance where 40 mN was reached

(g) Write down what Y-force you are still measuring (should be approx 12 mN)

(h) Start the regimen

(i) Begin with the preconditioning, and proceed to stretch until failure

(j) The test results can be reviewed and displayed by selecting Analyse and Review
Images from the file menu and the test file (.tst)



B
Clamp Redesign Specifications

Appendix B includes the dimensions (mm) of the redesigned clamp at different view
angles. A redesign was necessary due the inadequate clamping technique of the commercial
clamps. Michiel Manten, from the Instrumentation department at Erasmus MC, created
the SolidWorks model shown below and manufactured the clamps based on the sketch
design I provided him.
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Figure B.1: Schematic drawing of clamp redesign with dimensions (mm). Top, side, back, and
orthogonal views. Material used: PVC plastic



C
Ncorr Software

Ncorr was the DIC software used in this study. Appendix C provides a tutorial of
how to use Ncorr using a construct mounted in the redesigned clamps as an example.
Furthermore, this appendix explains more about the mathematical algorithms used behind
the software.

C.1 Introduction

Ncorr is an open source 2D digital image correlation software, developed in the MATLAB
environment using C++/MEX by a Master’s student at the Georgia Institute of
Technology. This software allows the user to interact through the graphical user interface
(GUI) or through the MATLAB terminal. The Ncorr software and manual can be
downloaded at www.ncorr.com. The mathematical algorithms used in Ncorr and the
program’s work flow are described below.

C.2 Mathematical Algorithm

Ncorr uses a novel DIC algorithm technique developed by Pan known as reliability-guided
DIC (RG-DIC) [14]. This technique uses the Inverse Compositional Gauss-Newton (IC-
GN) method as the iterative solver, described later. RG-DIC begins with selecting a seed
point which determines the middle of the reference (undeformed) subset. The reference
subset consists of grayscale values per pixel with the corresponding coordinates. These
reference subset coordinates are transformed so that the grayscale values of the reference
and deformed subsets match (Figure C.1). Equations C.1-C.3 demonstrate this subset
transformation, where xcur and ycur, and xref and ycur are the x and y coordinates for the
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current and reference image; i and j represent the position of a point(x, y) with respect
to the subset center (c) where S is a set that contains all subset points; p denotes the
components of the vector for the transform (linear, first order at low strain) [27].

Figure C.1: Finding initial guess process: a) reference subset selected b) convolution with the current
image to find the normalized cross correlation c) array of correlation coefficient values are output,
maximum value is located d) subset location is recovered with respect to the first image [27]

x̃curi = xrefi + urc +
∂u

∂xrc
(xrefi − xrefc) +

∂u

∂yrc
(yrefj − yrefc) (i, j) ∈ S (C.1)

ỹcurj = yrefj + vrc +
∂v

∂xrc
(xrefi − xrefc) +

∂v

∂yrc
(yrefj − yrefc) (i, j) ∈ S (C.2)

p =

{
u v

∂u

∂x

∂u

∂y

∂v

∂x

∂v

∂y

}T
(C.3)

To quantitatively determine the quality of the match between the reference and deformed
image, the correlation criterion is used. The initial guess for the displacement is found by
computing the highest zero mean normalized cross correlation coefficient (CCC) around
the center point of the seeded subset. Normalizing and including the zero mean allows
the results to be invariant to affine shifts in grayscale values (by subtracting the average
grayscale values). The CCC method for initial guess determines the translation values
of the reference subset to the deformed image, but an iterative optimization method is
necessary to determine the rotations and strains. Using the IG-GN nonlinear optimizer,
the search path follows the minimum least squares criteria (CLS) in the surrounding
subsets and then converts the CLS to output CCC values due to its more intuitive range
of [-1 1] for the user. Equations C.4-C.6 represent the correlation criterion used in the



73 APPENDIX C. NCORR SOFTWARE

RG-DIC method, where f and g are the grayscale values at a subset point in the reference
and deformed images; fm and gm denotes the average grayscale values for the reference
and deformed subsets; S is the set with all of the subset points; and n(S) represents the
amount of subset points in S. The CLS criteria is related to the CCC criteria according
to equation C.5, where the normal degree of correlation would be flipped in this case
due to subtracting CLS by 1 to obtain CCC. For example, 0-0.5 ordinarily signifies a
weak correlation, but in this case these values would signify a strong correlation, where
0 represents a perfect match (commonly represented by 1) [28]. The displacement data
from the previous point is used as the initial guess for successive surrounding points, as
this prevents the use of bad data points (with high CLS) [14]. The RG-DIC approach can
be seen in Figure C.2.

CLS =
∑

(i,j)∈S

 f(x̃refi , ỹrefj)− fm√∑
(i,j)∈S[f(x̃refi , ỹrefj)− fm]2

−
g(x̃curi , ỹcurj)− gm√∑

(i,j)∈S[g(x̃curi , ỹcurj)− gm]2

2

(C.4)

CCC =

∑
(i,j)∈S(f(x̃refi , ỹrefj)− fm)(g(x̃curi , ỹcurj)− gm)√∑

(i,j)∈S[f(x̃refi , ỹrefj)− fm]2
∑

(i,j)∈S[g(x̃curi , ỹcurj)− gm]2
= 1− 0.5× CLS

(C.5)

fm =

∑
(i,j)∈S f(x̃refi , ỹrefj)

n(S)
gm =

∑
(i,j)∈S g(x̃curi , ỹcurj)

n(S)
(C.6)
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Figure C.2: Approach used by the RG-DIC algorithm in Ncorr. The path flows from the seeding point
in the direction of the lowest CLS for each step. [27]

To compute the Lagrangian strains, the four plane displacement gradients seen in C.7-C.9
were obtained by using a least squares plane fit on a subset of displacement data [27].
This was applied to the entire displacement field to obtain the strain field.
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C.3 Program Work Flow

The work flow of Ncorr is described in the steps below and further discussed in the
subsequent sections:

1. Starting Ncorr and Using Multithreading
2. Set Reference Image
3. Set Current Image(s)
4. Set Region of Interest
5. Set DIC Parameters
6. RG-DIC Analysis
7. Format Displacements
8. Calculate Strains

C.3.1 Starting Ncorr and using multithreading

Open the directory of Ncorr in MATLAB, and type “handles ncorr = ncorr” into the
command window. To use parallel processing, make sure a compiler is installed in
MATLAB. Check the “OpenMP Multithreading” box and input the number of cores
on the system being used (check this using task manager). Figure C.3 displays the start
GUI that should appear if the files were compiled correctly.

Figure C.3: Main start window of the Ncorr GUI
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C.3.2 Setting the reference and current image(s)

The first step is to load the reference image (undeformed), by selecting File>Load
Reference Image. Next, load the current image(s) in which deformation will be calculated
by selecting File>Load Current Image(s). If loading multiple images, the images must
follow the format below:

name #.ext

This program allows the image extensions including .jpg, .tif, .png, or .bmp. There is an
option to choose either to load and store all of the images in the workplace (Load All) or
to pull each image individually from its stored location (Load Lazy). The “Load Lazy”
option was used in this project and is advised to use when many images will be loaded to
save memory. The reference image and current images will display in the window, as seen
in Figure C.4 and the “Program State” will display “SET” for these completed steps.

Figure C.4: Reference and current images are set as seen under Program State

C.3.3 Setting the region of interest

The region of interest (ROI) can be loaded from a file, the user can draw it using the
provided features in the program, or thresholding can be used with high contrast images.
To load a pre-made ROI mask, the image must be the same size as the reference image.
The ROI must be colored white, whereas everything else in the image must be colored
black (Figure C.5). A simple image editor will be able to create this mask by loading the
reference image and drawing on it. Photopea online image editor was used for this study.
Drawing the ROI can be done by using the various shapes provided (rectangle, ellipse,
and freeform) which can be added or subtracted. The thresholding option can be used as
well, but may provide an inaccurate ROI selection with low contrasted images.
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Figure C.5: Uploaded .jpg file of ROI is set as seen under Program State

C.3.4 Selecting parameters and performing RG-DIC analysis

In order to perform the DIC analysis, the parameters must be set first by selecting
Analysis>Set DIC Parameters. The user can select the subset radius and subset spacing
and the preview will display on the right hand side of the window (Figure C.6). The
appropriate subset size is dependent on the image and speckle pattern quality. Too large
of a subset size can oversmooth the data, whereas too small of a subset size can introduce
noise. The subset spacing defines the number of points used in a subset and is linked
to the resolution of the image, where a smaller value will have higher resolution and a
larger value will have lower resolution. The key is to find the optimal balance for each of
these parameters based on the images.
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Figure C.6: Selecting the subset size and subset spacing in the RG-DIC Parameters window

The default options for the iterative solver were used in this analysis as it is recommended
to not adjust. In order to speed up the computational processing time, 4 cores were
used in the “Multithreading” option to run analysis on each construct in parallel. Due
to the low strain experienced in the constructs before rupture and the continuity of the
samples, the “High Strain Analysis” and “Discontinuous Analysis” options were not used.

When the DIC parameters have been set, select Analysis>Perform DIC Analysis and the
“Select Region” window will appear. Select the ROI and then select “Set Seeds”. The
number of seeds you must place on the ROI will match the number of cores you selected
to use. Seed placement provides initial guesses for the RG-DIC analysis and partitions
the ROI so that each region can be processed in parallel. When using multiple seeds,
make sure they are placed so that the regions are somewhat symmetric (Figure C.7). It
is also important to choose a seed point region that contains continuous displacement for
all images. After seeding has been processed, a window will appear of the seed subset
to verify the correct seeding placement has been performed and remains unique enough
through all of the images and that the images appropriately match the reference image
(Figure C.8). If the “Correlation Coefficient” and “# of Gauss Newton Iterations” are



79 APPENDIX C. NCORR SOFTWARE

too high or reach the cutoff value specified, another seeding location should be chosen.
The seed can also travel outside of the seeding location in certain images (especially with
the highest deformations), therefore it is important to check this before running analysis.

Figure C.7: The selected seeding points, which equal to number of cores selected under RG-DIC
Parameters (4). It is important that the seeds are placed so that the regions are subdivided somewhat
symmetrically as seen in this figure
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Figure C.8: Seed placement preview window. The user must make sure that the seeds do not travel
outside the current image as the sample deforms and that they converge properly by checking that the
correlation coefficient remains low and the number of iterations remain below the cutoff

C.3.5 Formatting displacements

Once analysis is complete, the user must appropriately format the displacements to
exclude points with a high CLS by selecting Analysis>Format Displacements. The user can
apply a scale by drawing a line on the reference image with a known distance. The scale
used in this study was 0.0093 mm/pixel. Next, a correlation coefficient cutoff (maximum)
value must be chosen and applied to all images. A value of 0.7 was selected as the
correlation coefficient cutoff in this project (which included data where CLS≤ 0.7) as it
excluded the weakly correlated values and the “bad data” points (Figure C.9).
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Figure C.9: Selection of scaling to 0.0093 mm/pixel and correlation coefficient cutoff, CLS≤ 0.7

C.3.6 Strain analysis

After formatting the displacements correctly, select the Analysis>Calculate Strains
option. The strain radius must be chosen which determines the amount of displacement
values used in order to determine the strain at each point using a least squares plane
fit based on the work of Bing Pan [14], as mentioned in Chapter 2. The type of strain
output can be set to Lagrangian or Eulerian (Lagrangian strain was selected for this
project) and the U or V displacements can be viewed as well. The window to the right
allows the user to view the plane fit of the selected region, which is draggable. It is
recommended to drag this point to high deformation regions and see if the curve fit is
still appropriate (Figure C.10).
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Figure C.10: Selection of strain radius=5. The least squares plane fit is shown in the right window

C.3.7 Plotting and obtaining data

The user is able to plot the displacements and strains calculated by selecting Plot>View
Displacement Plots or Plot>View Strain Plots. The upper and lower bounds of each
plot can be altered by the user. Figure C.11 displays an example plot of the Lagrangian
strain in the X direction. These images can be save by going to File>Save Image within
the plot window.
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Figure C.11: Lagrangian strain plot in the x direction

All of the data calculated by the analysis can be saved by selecting File>Save Data. This
data will then be accessible in the MATLAB working directory and can be easily loaded
into the workspace.



D
DIC Parameter Analysis

Appendix D includes the method used in order to select the appropriate parameters per
construct for DIC analysis.

D.1 Subset Size and Strain Radius Selection

The first step in DIC is selecting the appropriate parameters for each construct. In order
to do this, a quantitative technique was created to relatively compare parameters in
MATLAB. Using this relative comparison between subset sizes and strain radii, allows
the user to avoid values which include too much noise (depicted by holes in the strain
maps of D.1) as well as oversmoothing of the data. Only the first (reference) and last
image before rupture was used in the parameter analyses, as the algorithm is independent
of how many images were included.

Multiple analyses were ran on each construct where different subset sizes were applied,
ranging from 15-55 pixels with 10 pixel increments. X displacement plots were generated
for a horizontal section of the construct in order to compare subset sizes. The average
difference between each curve was calculated in MATLAB. The lowest average difference
was then selected as the most optimal, and subsequently the lower bound subset size
was selected. This same method was applied to select the appropriate strain radius per
construct (with 3, 5, 7, 15 pixels chosen to compare).

The parameter selection values can qualitatively be assessed by creating strain maps in
Ncorr with the different parameters applied to the construct, as shown in Figure D.1.
Figure D.2 shows a quantitative parameter selection example of a construct comparing
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the parameter output values for the X displacement and strain. A subset size of 35 pixels
was applied to all constructs except for two, in which 45 pixels was a better option due
to the sub-optimal speckle pattern (sparsity in some regions). A strain radius of 5 pixels
was chosen as the most optimal value for all constructs. A subset spacing of 3 pixels was
chosen for all constructs, as this value proved to output the best resolution without losing
data.

Figure D.1: Green-Lagrangian strain maps in the X direction derived from Ncorr allow a visual
comparison of the different parameter sizes. The parameter values of the middle column were chosen for
this construct, as it contained the least amount of noise and smoothing effect, which was quantitatively
verified with the parameter analysis method mentioned and shown in Figure 3.9

Figure D.2: X displacement and strain plots across half a construct from the lumen area to the SI
comparing a) subset sizes and b) strain radii sizes. A subset size of 35 pixels and strain radius of 5
were chosen for this construct, as these values demonstrated the most optimal balance between noise and
oversmoothing when analyzing the average relative differences between each parameter curve
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D.2 2D Correlation Coefficient Maps

To verify the appropriate parameter selection from the previous section, 2D correlation
coefficient maps were generated in MATLAB using the stored correlation coefficient
data from the parameter analyses (Figure D.3). An overall strong-moderately strong
correlation (CLS≤ 0.7) was observed throughout most of the constructs when comparing
the first (reference) image to the last image before rupture. This is also apparent near
the SI which is of particular interest for this study, therefore a cutoff value of 0.7 was
applied for final analyses using all images. One construct seen in D.3 did not contain a
speckle pattern around the SI and did not have very good correlation in general, which is
apparent in its correlation coefficient map (c), therefore it was excluded from DIC analysis
when investigating the region surrounding the SI. DIC was performed on the right side of
this construct as it showed a moderately good correlation.

Figure D.3: 2D correlation coefficient maps generated in MATLAB: static constructs tested in
redesigned clamps (a-c), static constructs tested in commercial clamps (d-g) and IS constructs tested in
commercial clamps (h-k). SI was not analyzed due to weak correlation in this region for most constructs.
green: strong correlation 0<CLS≤0.5, blue: moderately strong correlation 0.5<CLS≤0.7, yellow: weak
correlation 0.7<CLS<1.0, red: bad data 1.0≤CLS. The green and blue regions were included in the
analysis (moderately strong to strong correlation)

D.3 Optimizing Speckle Pattern

The graphite speckle patterns applied on each construct was assessed in the DIC software
and 2D correlation coefficient maps were made from the exported data. It was seen from
these correlation coefficient maps (Figure D.3) that most of the constructs contained



87 APPENDIX D. DIC PARAMETER ANALYSIS

good correlation data (defined as < 0.7) with respect to the reference image, however
a few regions displayed a bad correlation (defined as > 0.7), specifically near the SI or
edges, therefore there is room for improving the DIC speckle pattern application for
future experiments. By using a dabbing technique to apply the graphite, clusters of
particles as well as regions of sparsity were created, which are not optimal for DIC analysis.

In order to optimize the speckle pattern application for future DIC analysis, an unique
even speckle pattern is recommended. A better method to achieve this could be to apply
a dark paint via airbrush for the background creating appropriate contrast and then apply
a white paint via airbrush, making sure the paint does not detach when submerged into
PBS [29]. Also, outlining the soft inclusion would be recommended if using the above
method, in order to trace the boundary for DIC analysis more accurately. In this study,
the SI boundary was difficult to locate and had to be estimated through the speckle
pattern.

D.4 Optimizing Parameter Selection

In order to perform DIC analysis, the user must select the appropriate parameters for the
sample including subset size, spacing size, and strain radius. In this study, a relative error
approach was used to select the parameters, although establishing a ground truth is the
usual recommended method, which was discovered after testing was already performed.
There are a few methods used to choose these values by establishing the ground truth.
One way would be to perform rigid body translation analysis before mechanical testing.
For this method, an image of the initial position of the construct must be taken and
then the construct should be moved a known distance in one direction and another
image should be taken at this location. With this rigid body translation approach, the
uncertainty in the displacement and strain under uniform stretch can be determined
in Ncorr (deviation from zero). Therefore, the minimum error can be calculated for
different sizes of subset sizes and strain radii values, and give a more systematic method
for parameter selection [30]. It is recommended for future experiments, before the
mechanical testing is performed, to carry out rigid body translation analysis to obtain
appropriate parameter values.

Another method known as grey level co-occurence matrix (GLCM) could also be used
to choose an appropriate subset size for each construct [31]. GLCM uses offsets between
pixels of greyscale values and contrast to quantify the variation of spatial intensity. An
optimal DIC speckle pattern contains a low critical offset, in which the contrast values
saturate at a certain point. This method could not work in this study due to the sub-
optimal speckle pattern on the constructs. The images never saturated to a certain
contrast value, but rather continued to increase.



E
Supplementary Results

E.1 Linking local strain patterns to global behavior

Figure E.1 displays the global mechanical behavior of all of the tested constructs as
shown in the Results section, however black dots have been added to this plot to depict
the location of ε10% as determined by DIC analysis. This graph supports the speculation
that the commercial clamps could be causing micro-structural slippage within the tissue
near the clamp region due to the high amount of stretch variation at this location. Also,
these locations are at higher stretch overall in the commercial clamps when compared to
the redesigned clamps. This micro-structural slippage region could therefore be greatly
effecting the global mechanical properties reported for the entire construct.
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Figure E.1: Y force vs actuator Y displacement plots of all static (black) and all IS (red) constructs
until rupture: solid lines represent the new clamps, dotted lines represent the commercial clamps. This
plot is proportional to the nominal engineering stress vs strain plot. Black dots depict the location of
ε10% as determined by DIC analysis

E.2 X-Y displacement/strain maps for all constructs

X and Y displacement and X and Y Lagrangian strain maps at the image of ε10% and
at the image immediately before rupture are presented below for each of the constructs
(excluding the SI). The results section of this report focused on the ε10% location in
order to normalize the disparities that may be occurring near the clamp region with the
commercial clamps and to allow a more direct comparison between clamp designs. The
image immediately before rupture show similar trends to this image, but with a higher
magnitude.
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Figure E.2: Static construct tested in redesigned clamps (1/3)
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Figure E.3: Static construct tested in redesigned clamps (2/3)
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Figure E.4: Static construct tested in redesigned clamps (3/3). Inadequate speckle pattern was applied
therefore DIC was not comprehensive
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Figure E.5: Static construct tested in commercial clamps (1/4)
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Figure E.6: Static construct tested in commercial clamps (2/4)
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Figure E.7: Static construct tested in commercial clamps (3/4)
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Figure E.8: Static construct tested in commercial clamps (4/4)
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Figure E.9: IS construct tested in commercial clamps (1/4)
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Figure E.10: IS construct tested in commercial clamps (2/4)
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Figure E.11: IS construct tested in commercial clamps (3/4)
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Figure E.12: IS construct tested in commercial clamps (4/4)
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E.3 Average X-Y strain plots across all constructs

The average εxx and εyy values across the constructs divided into the shoulder and mid
cap regions are plotted below (excluding the SI). The data presented is located at the
image where ε10%. The grey dotted lines represent the right and left most point of the SI.
Some constructs do not contain all regions specified in the methods section.
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Figure E.13: Static construct tested in redesigned clamps (1/3)
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Figure E.14: Static construct tested in redesigned clamps (2/3)
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Figure E.15: Static construct tested in redesigned clamps (3/3)
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Figure E.16: Static construct tested in commercial clamps (1/4)
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Figure E.17: Static construct tested in commercial clamps (2/4)
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Figure E.18: Static construct tested in commercial clamps (3/4)
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Figure E.19: Static construct tested in commercial clamps (4/4)
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Figure E.20: IS construct tested in commercial clamps (1/4)



110 APPENDIX E. SUPPLEMENTARY RESULTS

Figure E.21: IS construct tested in commercial clamps (2/4)
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Figure E.22: IS construct tested in commercial clamps (3/4)
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Figure E.23: IS construct tested in commercial clamps (4/4)
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E.4 X-Y strain variation example

The shaded plots below represent the variation in εxx and εyy values within the shoulder
and mid cap regions going across the static construct tested in the commercial clamps.
The red and blue lines represent the top and bottom most values for each region, with
the grey signifying the range of values in between. It was observed that most variation
occurred towards the edges of the construct where compaction occurred.
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Figure E.24: Static construct tested in commercial clamps (1/1)
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E.5 Scatter plots: average X-Y regional strain

The scatter plots displayed below represent the average εxx and εyy values in each of the
8 regions for each construct.

Figure E.25: Static constructs
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Figure E.26: Static constructs
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Figure E.27: Static constructs
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Figure E.28: IS constructs
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Figure E.29: IS constructs
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E.6 DIC analysis: SI region example

There were only two constructs that had a good correlation in the SI region (<0.7),
therefore analysis including the SI was not performed. Figure E.30 shows an example of
the εxx and εyy maps of a construct which included the SI region before rupture. It can be
seen that the εyy is highest in the SI region and high εxx values (tension) are seen within
this region as well, with X compression occurring at the immediate left and right sides of
the SI, following the same trend seen previously. This can possibly show that both X and
Y strain play an important role in rupture at the interface between the SI and tissue.

Figure E.30: Static construct tested with commercial clamps including the SI region: a) εxx map b)
εyy map



F
Matlab code

Appendix E includes the MATLAB code created in this study to perform analysis.

F.1 Tissue Culture Analysis

F.1.1 Plotting average compaction

1 % The f o l l o w i n g code p l o t s the average compaction in the X,Y, Z
d i r e c t i o n s

2 % f o r both the s t a t i c and IS c o n s t r u c t s
3

4 X Stat= −16.35; % average va lue s were c a l c u l a t e d in Excel and
imported

5 X IS= −46.92;
6

7 Y Stat= −12.52;
8 Y IS= −2.05;
9

10 Z Stat= −80.94;
11 Z IS= −75.0;
12

13 X Stat sd= 6 . 0 7 ; % standard dev i a t i on va lues were c a l c u l a t e d
in Excel and imported

14 X IS sd= 3 . 7 4 ;
15
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16 Y Stat sd= 9 . 9 6 ;
17 Y IS sd= 6 . 6 7 ;
18

19 Z Stat sd= 3 . 9 2 ;
20 Z IS sd= 1 . 5 6 ;
21

22 f i g u r e (1 )
23 % Plot X
24 x = 0.33 ∗ ones (1 , l ength ( X Stat ) ) ;
25 p lo t (x , X Stat , ’b . ’ , ’ MarkerSize ’ , 12 , ’ LineWidth ’ , 3) ; hold on
26 p lo t (x , X IS , ’ r . ’ , ’ MarkerSize ’ , 12 , ’ LineWidth ’ , 3) ;
27 e r r o rba r (x , X Stat , X Stat sd , ’b ’ )
28 e r r o rba r (x , X IS , X IS sd , ’ r ’ )
29 g r id on ;
30 hold on ;
31 % Plot Y
32 x = 0.66 ∗ ones (1 , l ength ( Y Stat ) ) ;
33 p lo t (x , Y Stat , ’b . ’ , ’ MarkerSize ’ , 12 , ’ LineWidth ’ , 3) ; hold on
34 p lo t (x , Y IS , ’ r . ’ , ’ MarkerSize ’ , 12 , ’ LineWidth ’ , 3) ; hold on
35 e r r o rba r (x , Y Stat , Y Stat sd , ’b ’ )
36 e r r o rba r (x , Y IS , Y IS sd , ’ r ’ )
37 % Plot Z
38 x = 1 ∗ ones (1 , l ength ( Z Stat ) ) ;
39 p lo t (x , Z Stat , ’b . ’ , ’ MarkerSize ’ , 12 , ’ LineWidth ’ , 3) ; hold on
40 p lo t (x , Z IS , ’ r . ’ , ’ MarkerSize ’ , 12 , ’ LineWidth ’ , 3) ;
41 e r r o rba r (x , Z Stat , Z Stat sd , ’b ’ )
42 e r r o rba r (x , Z IS , Z IS sd , ’ r ’ )
43 % Set up axes .
44 xlim ( [ 0 , 1 . 3 3 ] ) ;
45 ylim ([−100 , 1 0 ] ) ;
46 y l a b e l ( ’ Average Compaction %’ ) ;
47 ax = gca ;
48 ax . XTick = [ 0 . 3 3 , 0 . 6 6 , 1 ] ;
49 ax . XTickLabels = { ’X ’ , ’Y ’ , ’Z ’ } ;
50 g r id on ;
51 l egend ( ’ S t a t i c ’ , ’ IS ’ )
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F.2 DIC Parameter Analysis

F.2.1 Subset size and strain radius selection

1 % This s c r i p t p l o t s the X−Y disp lacements and X−Y
2 % s t r a i n s a c r o s s the cons t ruc t at one h o r i z o n t a l
3 % s e c t i o n and compares the subset s i z e s and s t r a i n
4 % rad iu s s i z e s by c a l c u l a t i n g the average d i f f e r e n c e s between

each
5

6 %load a n a l y s i s data with subset s i z e s 15 ,25 ,35 ,45 ,55
7

8 A = load ( ’ sample# subse t15 . mat ’ ) ;
9 % load X−Y (u−v ) disp lacement data

10 B= A. d a t a d i c s a v e . d i sp lacements . p l o t u d i c ;
11 C= A. d a t a d i c s a v e . d i sp lacements . p l o t v d i c ;
12 % determine s e c t i o n to i n v e s t i g a t e & convert p i x e l s to mm
13 u 15 = B(279 ,151 :263 ) ∗0 . 0093 ;
14 v 15 = C(279 ,151 :263) ∗0 . 0093 ;
15

16 G = load ( ’ sample# subse t25 . mat ’ ) ;
17 H= G. d a t a d i c s a v e . d i sp lacements . p l o t u d i c ;
18 I= G. d a t a d i c s a v e . d i sp lacements . p l o t v d i c ;
19 u 25 = H(279 ,151 :263) ∗0 . 0093 ;
20 v 25 = I (279 ,151 :263) ∗0 . 0093 ;
21

22 G = load ( ’ sample# subse t35 . mat ’ ) ;
23 H= G. d a t a d i c s a v e . d i sp lacements . p l o t u d i c ;
24 I= G. d a t a d i c s a v e . d i sp lacements . p l o t v d i c ;
25 u 35 = H(279 ,151 :263) ∗0 . 0093 ;
26 v 35 = I (279 ,151 :263) ∗0 . 0093 ;
27

28 G = load ( ’ sample# subse t45 . mat ’ ) ;
29 H= G. d a t a d i c s a v e . d i sp lacements . p l o t u d i c ;
30 I= G. d a t a d i c s a v e . d i sp lacements . p l o t v d i c ;
31 u 45 = H(279 ,151 :263) ∗0 . 0093 ;
32 v 45 = I (279 ,151 :263) ∗0 . 0093 ;
33

34 G = load ( ’ sample# subse t55 . mat ’ ) ;
35 H= G. d a t a d i c s a v e . d i sp lacements . p l o t u d i c ;
36 I= G. d a t a d i c s a v e . d i sp lacements . p l o t v d i c ;
37 u 55 = H(279 ,151 :263) ∗0 . 0093 ;
38 v 55 = I (279 ,151 :263) ∗0 . 0093 ;
39
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40 %load a n a l y s i s data with s t r a i n rad iu s ( s r ) 3 ,5 ,7 ,15
41

42 J = load ( ’ sample# s u b s e t 3 5 s r 3 . mat ’ ) ;
43 % load X−Y s t r a i n data
44 K= J . d a t a d i c s a v e . s t r a i n s . p l o t e x x r e f f o r m a t t e d ;
45 L= J . d a t a d i c s a v e . s t r a i n s . p l o t e y y r e f f o r m a t t e d ;
46 exx 35 3 3 = K(279 ,151 :263 ) ;
47 eyy 35 3 3 = L(279 ,151 :263) ;
48

49 M = load ( ’ sample# s u b s e t 3 5 s r 5 . mat ’ ) ;
50 N= M. d a t a d i c s a v e . s t r a i n s . p l o t e x x r e f f o r m a t t e d ;
51 O= M. d a t a d i c s a v e . s t r a i n s . p l o t e y y r e f f o r m a t t e d ;
52 exx 35 3 5 = N(279 ,151 :263) ;
53 eyy 35 3 5 = O(279 ,151 :263) ;
54

55 P = load ( ’ sample# s u b s e t 3 5 s r 7 . mat ’ ) ;
56 Q= P. d a t a d i c s a v e . s t r a i n s . p l o t e x x r e f f o r m a t t e d ;
57 R= P. d a t a d i c s a v e . s t r a i n s . p l o t e y y r e f f o r m a t t e d ;
58 exx 35 3 7 = Q(279 ,151 :263) ;
59 eyy 35 3 7 = R(279 ,151 :263) ;
60

61 P = load ( ’ sample# s u b s e t 3 5 s r 1 5 . mat ’ ) ;
62 Q= P. d a t a d i c s a v e . s t r a i n s . p l o t e x x r e f f o r m a t t e d ;
63 R= P. d a t a d i c s a v e . s t r a i n s . p l o t e y y r e f f o r m a t t e d ;
64 exx 35 3 15 = Q(279 ,151 :263) ;
65 eyy 35 3 15 = R(279 ,151 :263) ;
66

67 x1 = ( 1 : 1 1 3 ) ; %determine how many x va lue s
68

69 %Plot the X−Y disp lacement and s t r a i n s , comparing parameter
s i z e s

70

71 f i g u r e (1 )
72 p lo t ( x1 , u 15 , ’b ’ , x1 , u 25 , ’ g ’ , x1 , u 35 , ’ r ’ , x1 , u 45 , ’ c ’ , x1 , u 55 , ’ k

’ ) ;
73 x l a b e l ( ’Lumen to s o f t i n c l u s i o n ’ )
74 y l a b e l ( ’X disp lacement (mm) ’ )
75 l egend ( ’ Subset=15 ’ , ’ Subset=25 ’ , ’ Subset=35 ’ , ’ Subset=45 ’ , ’ Subset

=55 ’ )
76

77 f i g u r e (2 )
78 p lo t ( x1 , v 15 , ’b ’ , x1 , v 25 , ’ g ’ , x1 , v 35 , ’ r ’ , x1 , v 45 , ’ c ’ , x1 , v 55 , ’ k

’ ) ;
79 x l a b e l ( ’Lumen to s o f t i n c l u s i o n ’ )
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80 y l a b e l ( ’Y disp lacement (mm) ’ )
81 l egend ( ’ Subset=15 ’ , ’ Subset=25 ’ , ’ Subset=35 ’ , ’ Subset=45 ’ , ’ Subset

=55 ’ )
82

83 f i g u r e (3 )
84 p lo t ( x1 , exx 35 3 3 , ’b ’ , x1 , exx 35 3 5 , ’ g ’ , x1 , exx 35 3 7 , ’ r ’ , x1 ,

exx 35 3 15 , ’ k ’ ) ;
85 x l a b e l ( ’Lumen to s o f t i n c l u s i o n ’ )
86 y l a b e l ( ’Exx ’ )
87 l egend ( ’SR=3 ’ , ’SR=5 ’ , ’SR=7 ’ , ’SR=15 ’ )
88

89 f i g u r e (4 )
90 p lo t ( x1 , eyy 35 3 3 , ’b ’ , x1 , eyy 35 3 5 , ’ g ’ , x1 , eyy 35 3 7 , ’ r ’ , x1 ,

eyy 35 3 15 , ’ k ’ ) ;
91 x l a b e l ( ’Lumen to s o f t i n c l u s i o n ’ )
92 y l a b e l ( ’Eyy ’ )
93 l egend ( ’SR=3 ’ , ’SR=5 ’ , ’SR=7 ’ , ’SR=15 ’ )
94

95 % Calcu la te the average d i f f e r e n c e between curves
96

97 % X disp lacement
98 PDif = u 25−u 15 ; %d i f f e r e n c e between subset s i z e 15 & 25
99 PDif = abs ( PDif ) ; %abso lu t e va lues taken from matrix

100 Pdi f uavg 15 25 = mean( PDif ) ; %average determined
101

102 PDif = u 35−u 25 ;
103 PDif = abs ( PDif ) ;
104 Pdi f uavg 25 35 = mean( PDif ) ;
105

106 PDif = u 45−u 35 ;
107 PDif = abs ( PDif ) ;
108 Pdi f uavg 35 45 = mean( PDif ) ;
109

110 PDif = u 55−u 45 ;
111 PDif = abs ( PDif ) ;
112 Pdi f uavg 45 55 = mean( PDif ) ;
113

114 % Y disp lacement
115 PDif = v 25−v 15 ;
116 PDif = abs ( PDif ) ;
117 Pdi f vavg 15 25 = mean( PDif ) ;
118

119 PDif = v 35−v 25 ;
120 PDif = abs ( PDif ) ;
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121 Pdi f vavg 25 35 = mean( PDif ) ;
122

123 PDif = v 45−v 35 ;
124 PDif = abs ( PDif ) ;
125 Pdi f vavg 35 45 = mean( PDif ) ;
126

127 PDif = v 55−v 45 ;
128 PDif = abs ( PDif ) ;
129 Pdi f vavg 45 55 = mean( PDif ) ;
130

131 % X s t r a i n
132 PDif = exx 35 3 3−exx 35 3 5 ;
133 PDif = abs ( PDif ) ;
134 Pdi f xavg 3 5 = mean( PDif ) ;
135

136 PDif = exx 35 3 5−exx 35 3 7 ;
137 PDif = abs ( PDif ) ;
138 Pdi f xavg 5 7 = mean( PDif ) ;
139

140 PDif = exx 35 3 7−exx 35 3 15 ;
141 PDif = abs ( PDif ) ;
142 Pdi f xavg 7 15 = mean( PDif ) ;
143

144 % Y s t r a i n
145 PDif = eyy 35 3 3−eyy 35 3 5 ;
146 PDif = abs ( PDif ) ;
147 Pdi f yavg 3 5 = mean( PDif ) ;
148

149 PDif = eyy 35 3 5−eyy 35 3 7 ;
150 PDif = abs ( PDif ) ;
151 Pdi f yavg 5 7 = mean( PDif ) ;
152

153 PDif = eyy 35 3 7−eyy 35 3 15 ;
154 PDif = abs ( PDif ) ;
155 Pdi f yavg 7 15 = mean( PDif ) ;
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F.2.2 2D correlation coefficient maps

1 %% Creat ing 2D Cor r e l a t i on C o e f f i c i e n t Color−coded Plot s
2

3 % 0<CC<=0.5 i s s t rong c o r r e l a t i o n ( green ) ,
4 % 0.5<CC<=0.7 i s moderate c o r r e l a t i o n ( blue ) ,
5 % 0.7<CC<1.0 i s weak c o r r e l a t i o n ( ye l low ) ,
6 % 1.0<=CC i s bad data ( red ) ,
7 % CC=0 i s background ( white )
8

9 % Sample #
10

11 CC = load ( ’ sample# subs e t #.mat ’ ) ; %load a n a l y s i s data
12 %load c o r r e l a t i o n c o e f f i c i e n t data
13 CC= CC. d a t a d i c s a v e . d i sp lacements . p l o t c o r r c o e f d i c ;
14 %c r e a t e c o l o r codes
15 rgb = [ 0 , 1 , 0 ; 0 , 0 , 1 ; 1 , 1 , 0 ; 1 , 0 , 0 ; 1 , 1 , 1 ] ;
16 %as s i gn c o l o r s to c o r r e l a t i o n c o e f f i c i e n t ranges
17 idx = 1∗(0<CC & CC<=0.5) + 2∗(0.5<CC & CC<=0.7) . . .
18 +3∗(0.7<CC & CC<1.0)+4∗(1.0<=CC) +5∗(CC==0) ;
19 idx (CC==0) = 5 ; %a s s i g n a white background
20 image ( idx ) %c r e a t e c o l o r map
21 colormap ( rgb )
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F.3 Data Analysis

F.3.1 Determining the image for each construct at 10% average
mid cap Y strain

1 % This s c r i p t f i n d s the image # of a cons t ruc t where the average
Y s t r a i n=10%

2 % within a c e r t a i n de f ined mid cap reg i on in order to run
a n a l y s i s and

3 % normal ize the clamp r e g i o n s
4

5 % To d e f i n e t h i s mid cap reg ion , the rows and columns were
s e l e c t e d from the

6 % disp lacement mask output from Ncorr . The reg ion ’ s s i d e
boundar ies were

7 % s e l e c t e d as 20% from the edges , us ing the top and bottom of
the SI as the

8 % top/bottom boundar ies
9

10

11 % load the Ncorr output f i l e
12 A = load ( ’ sample#.mat ’ ) ;
13

14 % load the Y s t r a i n s per p i x e l f o r a l l images ( i . e . 3 89 ) u n t i l
rupture

15 f o r i =1:389
16 E{ i}= A. d a t a d i c s a v e . s t r a i n s ( i ) . p l o t e y y r e f f o r m a t t e d ;
17 end
18

19 % Create the r eg i on in each image ( cut the matr i ce s )
20 AMC R = c e l l ( s i z e (389) ) ;
21 f o r i =1:389
22 E{1 , i } (256 :312 , 350 :404) ; % example o f box

boundar ies
23 AMC R{ : , i } = ans ;
24 end
25

26 % nan a l l z e r o e s to c a l c u l a t e mean
27 f o r i =1:389
28 AMC R{1 , i }(AMC R{1 , i }==0)=nan ;
29 end
30

31 f o r i =1:389
32 a{1 , i } = mean(AMC R{1 , i } , ’ omitnan ’ ) ; % take mean o f a l l
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rows
33 a2 {1 , i } = mean( a{1 , i } , ’ omitnan ’ ) ; % take mean o f a l l

columns
34 end
35

36 a2=ce l l 2mat ( a2 ) ; % convert c e l l to
array

37 va l = 0 . 1 0 0 0 ; % i n t e r e s t e d in 10% Y
s t r a i n

38 [ d , i x ] = min ( abs ( a2−va l ) ) ; % f i n d the image #
c l o s e s t to 0 .1

39 a2 ( ix −1: i x +1) ; % ix = image #
c l o s e s t to 0 .1

40 i x v a l u e = a2 ( ix ) ; % i x v a l u e = actua l y
s t r a i n at ix

41

42 % Plot image # vs average Y s t r a i n f o r a l l c o n s t r u c t s (mark 10%
Y s t r a i n )

43 x = 1 : l ength ( a2 ) ; hold on
44 p lo t (x , a2 , ’ k ’ ) ;
45 y l a b e l ( ’ Average Y s t r a i n ’ )
46 x l a b e l ( ’ Image #’ )
47 t i t l e ({ ’ Midcap reg i on w/ most homogenous s t r a i n pattern ’ , ’ (20%

away from edges / SI ) ’ })
48 ylim ( [ 0 0 . 4 5 ] ) ;
49 l egend ( ’ S t a t i c 1 ’ , ’ S t a t i c 2 ’ , ’ S t a t i c 3 ’ , ’ S t a t i c 4 ’ , ’ IS 1 ’ , ’ IS 2

’ , ’ IS 3 ’ , ’ IS 4 ’ , ’ l o c a t i o n ’ , ’ no r t hea s t o u t s i d e ’ )
50 p lo t ( ix , i x va lue , ’ k . ’ , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ; hold on
51 t ex t ( ix −30, i x v a l u e +0.025 , ’ x=81 ’ , ’ FontSize ’ , 7)

F.3.2 Plotting the average εxx, εyy and εxy values across the
width of the constructs

1 % This s c r i p t p l o t s the average X, Y and XY s t r a i n ac r o s s the
width o f the

2 % cons t ruc t with the o r i g i n at the cen te r o f the SI
3

4 A = load ( ’ sample#.mat ’ ) ; % load the Ncorr output f i l e
5

6 % Mid cap reg i on
7

8 % Right s i d e
9 % load X ( and Y: eyy ) s t r a i n s per p i x e l f o r the pre−determined
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image # f o r t h i s
10 % construct ’ s a n a l y s i s ( i . e . 175)
11 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
12

13 F = D(213 :268 , 335 :410) ; % determine boundar ies o f
r eg i on

14 F(F==0)=nan ; % nan a l l z e r o e s to c a l c u l a t e
average

15 avg = mean(F , ’ omitnan ’ ) ; % c a l c u l a t e the averages f o r
each column

16

17 % s e t the X a x i s va lue s
18 Xf= (75/25) ;
19 x avg = l i n s p a c e ( (1/25) , Xf , l ength ( avg ) ) ;
20

21 % plo t the s t r a i n va lue s ( with cent e r o f SI=0)
22 p lo t ( x avg , avg , ’b ’ , ’ LineWidth ’ , 2 ) ; hold on
23 y l a b e l ( ’X s t r a i n ’ )
24 x l a b e l ( ’ Distance from cente r o f SI to lumen (mm) ’ )
25 % t i t l e ( ’ IS 2− mid cap , x s t r a i n averages ’ )
26 ylim ([−0.1 0 . 1 4 ] ) ;
27 l egend ( ’ Right s i d e ’ , ’ Le f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r th ea s t ou t s i d e ’ )
28

29 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
30

31 F 2 = D(213 :268 , 410 :459) ;
32 F 2 ( F 2==0)=nan ;
33 Avg = mean( F 2 , ’ omitnan ’ ) ;
34

35 Xf 2= (124/25) ;
36 x Avg = l i n s p a c e ( (75/25) , Xf 2 , l ength (Avg) ) ;
37

38 p lo t ( x Avg , Avg , ’b ’ , ’ LineWidth ’ ,2 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ;
hold on

39 l egend ( ’ Right s i d e ’ , ’ Le f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r th ea s t ou t s i d e ’ )
40

41 % Lef t s i d e
42 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
43

44 % f l i p the data to r e p r e s en t i t on the l e f t s i d e o f the SI
45 F = f l i p l r (D(213 :268 , 258 :335) ) ;
46 F(F==0)=nan ;
47 avg = mean(F , ’ omitnan ’ ) ;
48
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49 Xf= (77/25) ;
50 x avg = l i n s p a c e ( (1/25) , Xf , l ength ( avg ) ) ;
51 x avg= −x avg ;
52

53 p lo t ( x avg , avg , ’ r ’ , ’ LineWidth ’ , 2 ) ; hold on
54 l egend ( ’ Right s i d e ’ , ’ Le f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r th ea s t ou t s i d e ’ )
55

56 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
57

58 F 2 = f l i p l r (D(213 :268 , 207 :258) ) ;
59 F 2 ( F 2==0)=nan ;
60 Avg = mean( F 2 , ’ omitnan ’ ) ;
61

62 Xf 2= (128/25) ;
63 x Avg = l i n s p a c e ( (77/25) , Xf 2 , l ength (Avg) ) ;
64 x Avg= −x Avg ;
65

66 % Plot the r i g h t and l e f t s i d e mid cap average va lue s along
cons t ruc t

67 p lo t ( x Avg , Avg , ’ r ’ , ’ LineWidth ’ ,2 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ )
68 l egend ( ’ Right s i d e ’ , ’ Le f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r th ea s t ou t s i d e ’ )
69 x1= x l i n e ( 1 . 0 4 , ’ k−. ’ , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ; % 30/25 , SI

r eg i on
70 x2= x l i n e (−1.08 , ’ k−. ’ , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ; % 30/25 , SI

r eg i on
71

72 %% Shoulder r eg i on
73

74 % Right top
75 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
76

77 F = D(126 :212 , 335 :410) ;
78 F(F==0)=nan ;
79 avg = mean(F , ’ omitnan ’ ) ;
80

81 Xf= (75/25) ;
82 x avg = l i n s p a c e ( (1/25) , Xf , l ength ( avg ) ) ;
83

84 p lo t ( x avg , avg , ’b ’ , ’ LineWidth ’ , 2 ) ; hold on
85 y l a b e l ( ’X s t r a i n ’ )
86 x l a b e l ( ’ Distance from cente r o f SI to lumen (mm) ’ )
87 % t i t l e ( ’ IS 2− shou lder reg ions , x s t r a i n averages ’ )
88 ylim ([−0.1 0 . 1 4 ] ) ;
89 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’
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Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )
90

91 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
92

93 F 2 = D(126 :212 , 410 :459) ;
94 F 2 ( F 2==0)=nan ;
95 Avg = mean( F 2 , ’ omitnan ’ ) ;
96

97 Xf 2= (124/25) ;
98 x Avg = l i n s p a c e ( (75/25) , Xf 2 , l ength (Avg) ) ;
99

100 p lo t ( x Avg , Avg , ’b ’ , ’ LineWidth ’ ,2 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ;
hold on

101 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’
Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )

102

103 % Lef t top
104 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
105

106 F = f l i p l r (D(126 :212 , 258 :335) ) ;
107 F(F==0)=nan ;
108 avg = mean(F , ’ omitnan ’ ) ;
109

110 Xf= (77/25) ;
111 x avg = l i n s p a c e ( (1/25) , Xf , l ength ( avg ) ) ;
112 x avg= −x avg ;
113

114 p lo t ( x avg , avg , ’ r ’ , ’ LineWidth ’ , 2 ) ; hold on
115 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’

Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )
116

117 % Lef t top
118 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
119

120 F 2 = f l i p l r (D(126 :212 , 207 :258) ) ;
121 F 2 ( F 2==0)=nan ;
122 Avg = mean( F 2 , ’ omitnan ’ ) ;
123

124 Xf 2= (128/25) ;
125 x Avg = l i n s p a c e ( (77/25) , Xf 2 , l ength (Avg) ) ;
126 x Avg= −x Avg ;
127

128 p lo t ( x Avg , Avg , ’ r ’ , ’ LineWidth ’ ,2 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ;
hold on
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129 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’
Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )

130

131

132 % Right bottom
133 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
134

135 F = D(269 :371 , 335 :410) ;
136 F(F==0)=nan ;
137 avg = mean(F , ’ omitnan ’ ) ;
138

139 Xf= (75/25) ;
140 x avg = l i n s p a c e ( (1/25) , Xf , l ength ( avg ) ) ;
141

142 p lo t ( x avg , avg , ’ k ’ , ’ LineWidth ’ , 2 ) ; hold on
143 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’

Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )
144

145 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
146

147 F 2 = D(269 :371 , 410 :459) ;
148 F 2 ( F 2==0)=nan ;
149 Avg = mean( F 2 , ’ omitnan ’ ) ;
150

151 Xf 2= (124/25) ;
152 x Avg = l i n s p a c e ( (75/25) , Xf 2 , l ength (Avg) ) ;
153

154 p lo t ( x Avg , Avg , ’ k ’ , ’ LineWidth ’ ,2 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ;
hold on

155 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’
Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )

156

157 % Lef t bottom
158 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
159

160 F = f l i p l r (D(269 :371 , 258 :335) ) ;
161 F(F==0)=nan ;
162 avg = mean(F , ’ omitnan ’ ) ;
163

164 Xf= (77/25) ;
165 x avg = l i n s p a c e ( (1/25) , Xf , l ength ( avg ) ) ;
166 x avg= −x avg ;
167

168 p lo t ( x avg , avg , ’ g ’ , ’ LineWidth ’ , 2 ) ; hold on
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169 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’
Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )

170

171 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
172

173 F 2 = f l i p l r (D(269 :371 , 207 :258) ) ;
174 F 2 ( F 2==0)=nan ;
175 Avg = mean( F 2 , ’ omitnan ’ ) ;
176

177 Xf 2= (128/25) ;
178 x Avg = l i n s p a c e ( (77/25) , Xf 2 , l ength (Avg) ) ;
179 x Avg= −x Avg ;
180

181 % plo t the top r i g h t and l e f t shou lde r s and bottom r i g h t and
l e f t shou lde r s

182 p lo t ( x Avg , Avg , ’ g ’ , ’ LineWidth ’ ,2 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ )
183 l egend ( ’Top r i g h t s i d e ’ , ’Top l e f t s i d e ’ , ’ Bottom r i g h t s i d e ’ , ’

Bottom l e f t s i d e ’ , ’ l o c a t i o n ’ , ’ n o r t hea s t ou t s i d e ’ )
184 x1= x l i n e ( 1 . 0 4 , ’ k−. ’ , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ; % add l i n e s to

d e f i n e the s i d e s o f the SI
185 x2= x l i n e (−1.08 , ’ k−. ’ , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ ) ;

F.3.3 Determining the average εxx, εyy and εxy values for the 8
regions

1 % This s c r i p t determines the average X, Y and XY s t r a i n va lue s
o f each o f the

2 % 8 r e g i o n s and p l o t s the se va lue s to compare
3

4 % The rows/columns o f the s e c t i o n s were determined manually from
the

5 % disp lacement mask output from Ncorr (1−8 r e g i o n s )
6

7 A = load ( ’ sample#.mat ’ ) ; % load the Ncorr output f i l e
8

9 % load the X (” exx ”) and Y (” eyy ”) s t r a i n s per p i x e l f o r the pre
−determined

10 %image # f o r t h i s const ruct ’ s a n a l y s i s ( i . e . 175)
11 D= A. d a t a d i c s a v e . s t r a i n s (175) . p l o t e x x r e f f o r m a t t e d ;
12

13 % f i n d the average f o r each o f the 8 r e g i o n s
14 D1= D(126 :212 , 258 :308) ; % boundar ies o f the r eg i on
15 D1(D1==0)=nan ; % nan a l l z e r o e s to c a l c u l a t e
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averages
16 D1 = mean(D1 , ’ omitnan ’ ) ; % take mean o f a l l rows
17 D1 = mean(D1 , ’ omitnan ’ ) ; % take mean o f columns
18

19 D2= D(126 :212 , 308 :361) ;
20 D2(D2==0)=nan ;
21 D2 = mean(D2 , ’ omitnan ’ ) ;
22 D2 = mean(D2 , ’ omitnan ’ ) ;
23

24 D3= D(126 :212 , 361 :410) ;
25 D3(D3==0)=nan ;
26 D3 = mean(D3 , ’ omitnan ’ ) ;
27 D3 = mean(D3 , ’ omitnan ’ ) ;
28

29 D4= D(213 :268 , 258 :308) ;
30 D4(D4==0)=nan ;
31 D4 = mean(D4 , ’ omitnan ’ ) ;
32 D4 = mean(D4 , ’ omitnan ’ ) ;
33

34 D5= D(213 :268 , 361 :410) ;
35 D5(D5==0)=nan ;
36 D5 = mean(D5 , ’ omitnan ’ ) ;
37 D5 = mean(D5 , ’ omitnan ’ ) ;
38

39 D6= D(269 :371 , 258 :308) ;
40 D6(D6==0)=nan ;
41 D6 = mean(D6 , ’ omitnan ’ ) ;
42 D6 = mean(D6 , ’ omitnan ’ ) ;
43

44 D7= D(269 :371 , 308 :361) ;
45 D7(D7==0)=nan ;
46 D7 = mean(D7 , ’ omitnan ’ ) ;
47 D7 = mean(D7 , ’ omitnan ’ ) ;
48

49 D8= D(269 :371 , 361 :410) ;
50 D8(D8==0)=nan ;
51 D8 = mean(D8 , ’ omitnan ’ ) ;
52 D8 = mean(D8 , ’ omitnan ’ ) ;
53

54 % Plot the averages o f each o f the 8 r e g i o n s
55 f i g u r e (1 )
56 % Plot mid cap reg i on averages
57 Midcap = [ D4 , D5 ] ;
58 x1 = 0 .5 ∗ ones (1 , l ength ( Midcap ) ) ;
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59 p lo t ( x1 , Midcap , ’b∗ ’ , ’ MarkerSize ’ , 4 , ’ LineWidth ’ , 3) ;
60 g r id on ;
61 hold on ;
62 % Plot shou lder r eg i on averages
63 Shoulder = [ D1 , D3 , D6 , D8 ] ;
64 T B= [ D2 , D7 ] ;
65 x = 1 ∗ ones (1 , l ength ( Shoulder ) ) ;
66 x2 = 1∗ ones (1 , l ength (T B) ) ;
67 p lo t (x , Shoulder , ’ r∗ ’ , ’ MarkerSize ’ , 4 , ’ LineWidth ’ , 3) ; hold on
68 p lo t ( x2 , T B , ’ g∗ ’ , ’ MarkerSize ’ , 4 , ’ LineWidth ’ , 3) ;
69 xlim ( [ 0 , 1 . 5 ] ) ;
70 ylim ( [−0.05 , 0 . 1 5 ] ) ;
71 y l a b e l ( ’X s t r a i n ’ ) ; % do the same f o r the Y s t r a i n s
72 t i t l e ( ’ IS 2 ’ ) ;
73 ax = gca ;
74 ax . XTick = [ 0 . 5 , 1 ] ;
75 ax . XTickLabels = { ’ Midcap ’ , ’ Shoulder ’ } ;
76 g r id on ;
77

78 % Add the r eg i on# next to each po int
79 t ex t (1+0.02 ,D1 , ’ 1 ’ , ’ FontSize ’ , 8)
80 t ex t (1+0.02 ,D2 , ’ 2 ’ , ’ FontSize ’ , 8)
81 t ex t (1+0.02 ,D3 , ’ 3 ’ , ’ FontSize ’ , 8)
82 t ex t (1+0.02 ,D6 , ’ 6 ’ , ’ FontSize ’ , 8)
83 t ex t (1+0.02 ,D7 , ’ 7 ’ , ’ FontSize ’ , 8)
84 t ex t (1+0.02 ,D8 , ’ 8 ’ , ’ FontSize ’ , 8)
85 t ex t (0 .5+0 .02 ,D4 , ’ 4 ’ , ’ FontSize ’ , 8)
86 t ex t (0 .5+0 .02 ,D5 , ’ 5 ’ , ’ FontSize ’ , 8)

F.3.4 Plotting the actuator Y displacement vs Y force and
calculating the tangential stiffness for each construct

1 % This s c r i p t p l o t s the actuator Y disp lacement vs Y f o r c e
ex t rac t ed from

2 % the Excel f i l e s f o r each cons t ruc t
3

4 % e xt r a c t the s p e c i f i c rows/columns from each Excel f i l e
5 S 1=x l s r e ad ( ’ S t a t i c 1 . x l sx ’ , ’G907 : I1300 ’ ) ;
6 S 1 ( : , 2 ) = [ ] ;
7

8 S 2=x l s r e ad ( ’ S t a t i c 2 . x l sx ’ , ’G907 : I1212 ’ ) ;
9 S 2 ( : , 2 ) = [ ] ;

10
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11 S 3=x l s r e ad ( ’ S t a t i c 3 . x l sx ’ , ’G909 : I1301 ’ ) ;
12 S 3 ( : , 2 ) = [ ] ;
13

14 S 4=x l s r e ad ( ’ S t a t i c 4 . x l sx ’ , ’G907 : I1509 ’ ) ;
15 S 4 ( : , 2 ) = [ ] ;
16

17 S 5=x l s r e ad ( ’ S t a t i c 5 . x l sx ’ , ’G907 : I1256 ’ ) ;
18 S 5 ( : , 2 ) = [ ] ;
19

20 S 6=x l s r e ad ( ’ S t a t i c 6 . x l sx ’ , ’G907 : I1109 ’ ) ;
21 S 6 ( : , 2 ) = [ ] ;
22

23 S 7=x l s r e ad ( ’ S t a t i c 7 . x l sx ’ , ’G907 : I1197 ’ ) ;
24 S 7 ( : , 2 ) = [ ] ;
25

26 IS 1=x l s r e ad ( ’ IS 1 . x l sx ’ , ’G907 : I1228 ’ ) ;
27 IS 1 ( : , 2 ) = [ ] ;
28

29 IS 2=x l s r e ad ( ’ IS 2 . x l sx ’ , ’G907 : I1138 ’ ) ;
30 IS 2 ( : , 2 ) = [ ] ;
31

32 IS 3=x l s r e ad ( ’ IS 3 . x l sx ’ , ’G908 : I1380 ’ ) ;
33 IS 3 ( : , 2 ) = [ ] ;
34

35 IS 4=x l s r e ad ( ’ IS 4 . x l sx ’ , ’G908 : I1255 ’ ) ;
36 IS 4 ( : , 2 ) = [ ] ;
37

38 % plo t the graphs f o r the s t a t i c c o n s t r u c t s
39 f i g u r e (1 )
40 p lo t ( S 1 ( : , 1 ) , S 1 ( : , 2 ) , ’ k ’ , S 2 ( : , 1 ) , S 2 ( : , 2 ) , ’ r ’ , S 4 ( : , 1 ) , S 4

( : , 2 ) , ’ r−− ’ , S 3 ( : , 1 ) , S 3 ( : , 2 ) , ’ k ’ , S 5 ( : , 1 ) , S 5 ( : , 2 ) , ’ r−− ’ , S 6
( : , 1 ) , S 6 ( : , 2 ) , ’ r−− ’ , S 7 ( : , 1 ) , S 7 ( : , 2 ) , ’ r−− ’ ) ; hold on

41 hold on
42 y l a b e l ( ’Y f o r c e (mN) ’ )
43 x l a b e l ( ’ Actuator Y disp lacement (um) ’ )
44 t i t l e ( ’ S t a t i c Constructs ’ )
45 xlim ( [ 0 3500 ] ) ;
46 ylim ( [ 0 3500 ] ) ;
47 l egend ( ’ S t a t i c {new , SI rupture } ’ , ’ S t a t i c {new , clamp rupture } ’

, ’ S t a t i c {old , clamp rupture } ’ , ’ l o c a t i o n ’ , ’ northwest ’ )
48 % add marker to the po int where average Y s t r a i n in mid cap =

10%
49 x = [527 614 230 1 4 4 5 ] ;
50 y = [342 424 13 6 1 1 ] ;
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51 p lo t (x , y , ’ k . ’ , ’ MarkerSize ’ ,10 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ )
52

53 % plo t the graphs f o r the IS c o n s t r u c t s
54 f i g u r e (2 )
55 p lo t ( IS 2 ( : , 1 ) , IS 2 ( : , 2 ) , ’ k−− ’ , IS 1 ( : , 1 ) , IS 1 ( : , 2 ) , ’ r−− ’ , IS 3

( : , 1 ) , IS 3 ( : , 2 ) , ’ r−− ’ , IS 4 ( : , 1 ) , IS 4 ( : , 2 ) , ’ k−− ’ ) ; hold on
56 hold on
57 y l a b e l ( ’Y f o r c e (mN) ’ )
58 x l a b e l ( ’ Actuator Y disp lacement (um) ’ )
59 t i t l e ( ’ I n t e r m i t t e n t l y St ra ined Constructs ’ )
60 xlim ( [ 0 3500 ] ) ;
61 ylim ( [ 0 3500 ] ) ;
62 l egend ( ’ IS {old , SI rupture } ’ , ’ I S {old , clamp rupture } ’ , ’

l o c a t i o n ’ , ’ northwest ’ )
63 x = [1396 1682 1784 2 1 6 6 ] ;
64 y = [408 719 652 1 1 0 8 ] ;
65 p lo t (x , y , ’ k . ’ , ’ MarkerSize ’ ,10 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ )
66

67 % plo t a l l c o n s t r u c t s on one graph
68 f i g u r e (3 )
69 p lo t ( S 1 ( : , 1 ) , S 1 ( : , 2 ) , ’ k ’ , S 4 ( : , 1 ) , S 4 ( : , 2 ) , ’ k−− ’ , S 2 ( : , 1 ) , S 2

( : , 2 ) , ’ k ’ , S 3 ( : , 1 ) , S 3 ( : , 2 ) , ’ k ’ , IS 1 ( : , 1 ) , IS 1 ( : , 2 ) , ’ r−− ’ ,
IS 2 ( : , 1 ) , IS 2 ( : , 2 ) , ’ r−− ’ , IS 3 ( : , 1 ) , IS 3 ( : , 2 ) , ’ r−− ’ , IS 4 ( : , 1 )
, IS 4 ( : , 2 ) , ’ r−− ’ , S 5 ( : , 1 ) , S 5 ( : , 2 ) , ’ k−− ’ , S 6 ( : , 1 ) , S 6 ( : , 2 ) , ’ k
−− ’ , S 7 ( : , 1 ) , S 7 ( : , 2 ) , ’ k−− ’ ) ; hold on

70 hold on
71 y l a b e l ( ’Y f o r c e (mN) ’ )
72 x l a b e l ( ’ Actuator Y disp lacement (um) ’ )
73 t i t l e ( ’New vs o ld clamps ’ )
74 xlim ( [ 0 3500 ] ) ;
75 ylim ( [ 0 3500 ] ) ;
76 l egend ( ’New clamps ’ , ’ Old clamps ’ , ’ l o c a t i o n ’ , ’ northwest ’ )
77 x = [527 614 230 1445 1396 1682 1784 2166 1274 1479 1 4 7 1 ] ;
78 y = [342 424 13 611 408 719 652 1108 633 541 8 3 8 ] ;
79 p lo t (x , y , ’ k . ’ , ’ MarkerSize ’ ,10 , ’ H a n d l e V i s i b i l i t y ’ , ’ o f f ’ )
80

81

82 %% Calcu la t ing the t a n g e n t i a l s t i f f n e s s f o r each cons t ruc t
83 % at 10% average mid cap Y s t r a i n l o c a t i o n
84

85 x = 1+S 1 ( : , 1 ) /10000; % convert to s t r e t c h r a t i o from Y
disp lacement

86 y = S 1 ( : , 2 ) / 4 . 6 ; % convert to kPa from Y f o r c e (mN) : area
= i n i t i a l width∗ avg th i ckne s s
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87

88 % Derived 5 parameter mooney r i v l i n s t r e s s equat ion f o r s t r a i n
energy dens i ty

89 % f ( x ) = 2∗C10∗(x−(1/x ) )+2∗C01∗(1−(1/x . ˆ 3 ) )+6∗C11∗(x.ˆ2−x
−1+(1/x . ˆ 2 ) +(1/x . ˆ 3 )−(1/x . ˆ 4 ) )+4∗C20∗x∗(1−(1/x . ˆ 3 ) ) ∗(x .ˆ2+(2/
x )−3)+4∗C02∗(2∗x+(1/x . ˆ 2 )−3)∗(1−(1/x . ˆ 3 ) )

90 % C o e f f i c i e n t s ( with 95% con f idence bounds ) :
91 C01 = −3942
92 C02 = 1.009 e+06
93 C10 = 5760
94 C11 = −1.797 e+06
95 C20 = 7.994 e+05
96

97 y s t r e t c h = 342/4 . 6 ;
98 [ d , i x ] = min ( abs (y−y s t r e t c h ) ) ; % f i n d the

image # c l o s e s t to 0 .1000
99 y ( ix −1: i x +1) ; % ix = image #

c l o s e s t to 0 .1000
100 i x v a l u e = y ( ix ) ; % s t r e s s @ 10%
101 s t r e t c h = x (82 ,1 ) ; % s t r e t c h @ 10 %
102

103 % d i f f e r e n t i a t e d Mooney R iv l i n f i t s t r e s s equat ion (TM:
t a n g e n t i a l modulus )

104 TM = 2.∗C10 + ( 2 .∗C10) . / s t r e t c h + ( 6 .∗C01 − 18 .∗C11 + 4.∗C20
. ∗ ( 3 . ∗ s t r e t c h .ˆ6 − 6 .∗ s t r e t c h +6) ) . / s t r e t c h .ˆ4 + 12 .∗C11 .∗
s t r e t c h + (24 .∗C11) . / s t r e t c h .ˆ5 − ( 12 .∗C11) . / s t r e t c h .ˆ3 − 6 .∗
C11 − 12 .∗C20 + ( 4 .∗C02 . ∗ ( 2 . ∗ s t r e t c h .ˆ3 − 9 .∗ s t r e t c h .ˆ2 + 5) )
. / s t r e t c h .ˆ6 + 8 .∗C02 ;

F.3.5 Statistical analysis

1 % This s c r i p t t e s t s the (X, Y and XY s t r a i n ) r e g i o n a l data s e t s
f o r normal ity ,

2 % t e s t s f o r homogenous var iances , per forms independent t t e s t s ,
and c r e a t e s boxplots

3

4 S=x l s r e ad ( ’ Sec t i on avgs . x l sx ’ , ’B3 : G32 ’ ) ; % e x t r a c t the
data s e t s from Excel f i l e

5

6 alpha = 0 . 0 5 ; % Shapiro−Wilk
t e s t ( t e s t normal i ty o f each data s e t at p=0.05)

7 [H, pValue , W] = swtes t ( new stat MC , alpha ) % H = 0 :
normal d i s t r i b u t i o n , H = 1 : not normal
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8

9 % Extract the c e l l s f o r each r e g i o n a l data s e t
10 S=x l s r e ad ( ’ Sec t i on avgs . x l sx ’ , ’B3 : J47 ’ ) ;
11

12 % X s t r a i n
13

14 new stat MC = S ( 1 : 5 , 1 ) ; % normal , n=4
15 new stat MC ( any ( i snan ( new stat MC ) ,2 ) , : ) = [ ] ;
16

17 new stat SE = S ( 1 : 5 , 4 ) ; % normal , n=4
18 new stat SE ( any ( i snan ( new stat SE ) ,2 ) , : ) = [ ] ;
19

20 new stat TB = S ( 1 : 5 , 7 ) ; % n=2, no s ta t s
, low power

21 new stat TB ( any ( i snan ( new stat TB ) ,2 ) , : ) = [ ] ;
22

23 old stat MC = S ( 7 : 2 5 , 1 ) ; % n=8, normal
24 old stat MC ( any ( i snan ( old stat MC ) ,2 ) , : ) = [ ] ;
25

26 o ld s ta t SE = S ( 7 : 2 5 , 4 ) ; % not normal , n
=16

27 o ld s ta t SE ( any ( i snan ( o ld s ta t SE ) ,2 ) , : ) = [ ] ;
28

29 o ld stat TB = S ( 7 : 2 5 , 7 ) ; % n=8, normal
30 o ld stat TB ( any ( i snan ( o ld stat TB ) ,2 ) , : ) = [ ] ;
31

32 IS MC = S ( 2 7 : 4 5 , 1 ) ; % normal , n=8
33 IS MC( any ( i snan (IS MC) ,2) , : ) = [ ] ;
34

35 IS SE = S ( 2 7 : 4 5 , 4 ) ; % normal , n=16
36 IS SE ( any ( i snan ( IS SE ) ,2 ) , : ) = [ ] ;
37

38

39 %% Boxplots c r ea ted f o r X, Y, and XY s t a i n f o r the mid cap ( l e f t
/ r i g h t SI ) , shoulder , and top/bottom SI r e g i o n s

40 %s t a t i c r e d e s i g n e d vs s t a t i c c ommerc i a l (MC)
41 % equal var i ance ?
42 X = [−0.0039 1 ; 0 . 0172 1 ; 0 . 0 4 2 1;−0.0102 1 ; −0.0512 2;−0.0185

2 ; 0 . 0122 2;−0.0072 2;−0.0075 2;−0.0139 2;−0.0072 2;−0.0033
2 ] ;

43 Levenetes t (X, alpha ) % yes
44

45 group = [ repmat ({ ’ F i r s t ’ } , 4 , 1) ; repmat ({ ’ Second ’ } , 8 , 1) ;
repmat ({ ’ Third ’ } , 8 , 1) ] ;
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46 boxplot ( [ new stat MC ; old stat MC ; IS MC ] , group , ’ Labe ls ’ ,{ ’ S t a t i c
(R) , n=4 ’ , ’ S t a t i c (C) , n=8 ’ , ’ IS (C) , n=8 ’ } , ’ Whisker ’ , 1 )

47 % t i t l e ( ’ Midcap reg ion ’ )
48 y l a b e l ( ’ Average X s t r a i n ’ )
49 ylim ([−0.06 0 . 0 6 ] ) ;
50

51 [ h , p ] = t t e s t 2 ( new stat MC , old stat MC ) % P=0.085 (
s t a t i s t i c a l l y comparable )

52

53 % sta t i c c ommerc i a l (MC) vs IS commerc ia l (MC)
54 X = [ 0 . 0 0 5 1 ; 0 . 0215 1;−0.0418 1;−0.0432 1;−0.0137 1 ; 0 . 0153

1;−0.0167 1;−0.0076 1 ; −0.0512 2;−0.0185 2 ; 0 . 0122 2;−0.0072
2;−0.0075 2;−0.0139 2;−0.0072 2;−0.0033 2 ] ;

55 Levenetes t (X, alpha ) % yes
56 [ h , p ] = t t e s t 2 ( old stat MC , IS MC) % P=0.085 ( s t a t i s t i c a l l y

comparable )
57

58

59 %% stat i c new , s t a t i c o l d , IS (SE)
60 % equal var i ance ?
61 X = [ 0 . 0 0 2 5 1 ; 0 . 0117 1 ; 0 . 0018 1;−0.0026 1 ; −0.043 2;−0.0194

2;−0.0496 2;−0.0192 2 ; 0 . 0033 2;−0.0114 2 ; 0 . 0025 2;−0.0102
2;−0.0112 2;−0.0208 2;−0.0078 2;−0.007 2;−0.0083 2;−0.0117
2;−3.80 e−04 2;−0.0099 2 ; −0.0137 3;−0.0014 3 ; 0 . 0233 3;−0.0211

3 ; 0 . 0 1 5 3;−0.0271 3;−0.0448 3;−0.01 3;−0.0307 3;−0.0147
3 ; 0 . 0036 3;−0.0264 3;−0.0128 3;−0.0283 3;−0.028 3;−0.0142
3;−0.0174 3 ] ;

62 Levenetes t (X, alpha ) % yes
63

64 group = [ repmat ({ ’ F i r s t ’ } , 4 , 1) ; repmat ({ ’ Second ’ } , 16 , 1) ;
repmat ({ ’ Third ’ } , 16 , 1) ] ;

65 boxplot ( [ new stat SE ; o ld s ta t SE ; IS SE ] , group , ’ Labe ls ’ ,{ ’ S t a t i c
(R) , n=4 ’ , ’ S t a t i c (C) , n=16 ’ , ’ IS (C) , n=16 ’ } , ’ Whisker ’ , 1 )

66 % t i t l e ( ’ Shoulder reg ion ’ )
67 y l a b e l ( ’ Average X s t r a i n ’ )
68 ylim ([−0.06 0 . 0 6 ] ) ;
69

70 [ h , p ] = t t e s t 2 ( new stat SE , o ld s ta t SE ) % P=0.03 (
s t a t i s t i c a l l y d i f f e r e n t , but o ld has few samples )

71 % [ h , p ] = t t e s t 2 ( new stat SE , IS SE ) % P=0.065 ( s t a t i s t i c a l l y
comparable )

72 [ h , p ] = t t e s t 2 ( o ld s tat SE , IS SE ) % P=0.91 ( s t a t i s t i c a l l y
comparable )

73
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74 %% stat i c new , s t a t i c o l d , IS (TB)
75 % equal var i ance ? s t a t i c o l d vs I S o l d
76 X = [ 5 . 4 4 6 8 e−04 1;−0.0066 1 ; 0 . 0244 1 ; 0 . 0 0 4 1 ; 0 . 0198 1 ; 0 . 0204

1 ; 0 . 0192 1 ; 0 . 0265 1 ; 0 .015 2;−0.0132 2 ; 0 . 0 0 6 2 ; 0 . 0 0 5 2 ; 0 . 0166
2 ; 0 . 0109 2 ; 0 . 0068 2 ; 0 . 0095 2 ] ;

77 Levenetes t (X, alpha ) % yes
78

79 group = [ repmat ({ ’ F i r s t ’ } , 2 , 1) ; repmat ({ ’ Second ’ } , 8 , 1) ;
repmat ({ ’ Third ’ } , 8 , 1) ] ;

80 boxplot ( [ new stat TB ; o ld stat TB ; IS TB ] , group , ’ Labe ls ’ ,{ ’ S t a t i c
(R) , n=2 ’ , ’ S t a t i c (C) , n=8 ’ , ’ IS (C) , n=8 ’ } , ’ Whisker ’ , 1 )

81 % t i t l e ( ’Top/Bottom SI Shoulder reg ion ’ )
82 y l a b e l ( ’ Average X s t r a i n ’ )
83 ylim ([−0.06 0 . 0 6 ] ) ;
84

85 [ h , p ] = t t e s t 2 ( old stat TB , IS TB ) % P=0.26 ( s t a t i s t i c a l l y
comparable )


